


INTRODUÇÃO

Este e-book destina-se a todos aqueles que têm 
curiosidade e querem aprender a estar online, pre-
parar e construir uma homepage, criar, personalizar 
e manter um blog, entre muitas outras coisas.

Não é um manual técnico, não vamos aqui usar vo-
cabulário complicado, os bits e os bytes ficam de 
fora. A linguagem é acessível, porque não é preciso 
complicar o que é simples e fácil.
Este e-book serve para responder às questões bási-
cas, serve para ensinar a dar os primeiros passos: 
Como registar uma homepage ou um blog, quais os 
melhores programas, onde é que se fazem todas es-
tas coisas de forma simples, rápida e grátis.
Seguindo passo-a-passo as instruções que aqui 
encontrará, ficará já com o seu blog ou com a sua 
homepage  (e messenger, e-mail, chats, etc.); depois 
disso, existe um mundo para explorar. 
Este e-book apenas vai abrir as portas desse mun-
do.
Depois de ler e usar este e-book será capaz de:
Índice

Planear
Processo criativo: 
- As ideias – como arranjá-las e escolher a melhor;
- Organização – qual a forma mais eficaz de expor a 
ideia;
- Objectivos – o que se pretende comunicar ou expor.
 
Pesquisar
- Como e onde encontrar o conteúdo certo (textos, fo-
tos, vídeos).

Seleccionar
- Como distinguir as boas das más fontes de informa-
ção.

Usar os conteúdos seleccionados sem cair na tenta-
ção de copiar. Referir as fontes de informação.
 
Editar
- Editar ficheiros de imagem, vídeo e som para que se 
adaptem às suas necessidades;
- Quais os programas de que vai precisar e onde os 
encontrar, muitas vezes, grátis.

Publicar
- Registar uma homepage, um blog ou um álbum de 
fotos, no SAPO; 
Personalizar o seu blog ou a sua homepage. Dar o 
seu estilo e toque pessoal. 

- "Olá mundo, aqui estou eu". Use a pesquisa a seu 
favor;
- O que são tags, para que servem; como se usam;
- A diferença entre divulgar e melgar.

Comunicar
- Perceber que o e-mail é muito mais do que um ende-
 reço de correio;
- Registar um endereço de e-mail. Como usar o e-mail; 
- A diferença entre spam e correspondência permitida;
- Boas maneiras online. Netiqueta.

Segurança
- “Não aceites doces de estranhos” – uma verdade 
universal, online também;
- Os meus dados pessoais são meus e de mais nin-
guém.

Para quem serve e a quem se destina este e-book

Divulgar
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PLANEAR

Objectivos

O que se pretende comunicar ou expor

De todos os passos deste e-book, começamos pelo 
maior desafio: ter boas ideias. Estas estão só à es-
pera que alguém as tenha, e até há técnicas especi-
ais para as conseguir “apanhar”.  
A primeira coisa a fazer é identificar o nosso objec-
tivo.
            
            - O que é que queremos comunicar?
 
            - O que é que queremos apresentar?
 
            - O que é que queremos dizer?

Seja um objectivo pessoal, profissional ou académi-
co/escolar, esta é a primeira coisa. Fazer uma lista 
dos objectivos que pretendemos atingir, e identificar 
o tema base do nosso projecto.

Queremos:

      - Apresentar o nosso currículo? 
      - Entregar um trabalho pedido pelo professor?
      - Fazer a versão online do jornal escolar?
      - Mostrar as nossas fotos aos amigos?
      - Fazer a página do clube de fãs do nosso grupo 
         favorito?

Os exemplos apresentados não passam disso mes-
mo, exemplos. 

Já temos a lista? Então já temos as fundações da 
casa. Agora vamos passar aos alicerces. 
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PLANEAR

A quem pretendemos transmitir?

Na realidade, uma ideia pode ser apresentada de 
muitas formas, depende obviamente de quem expõe 
o tema, mas também depende muito de quem vai ver 
o nosso trabalho.

Por exemplo, qual o tipo de vocabulário a usar? Se 
se destina a uma criança necessitará de uma lingua-
gem mais simples, se se destina a um adulto, 
poderemos usar uma linguagem mais elaborada.

É uma pessoa (ou um grupo de pessoas) que está 
familiarizada com eventuais termos técnicos ou pre-
cisa que estes termos técnicos lhe sejam explicados: 
não é óbvio para toda a gente que “o mar estava flat” 
significa na realidade “o mar estava calmo, sem apre-
sentar ondas que permitissem a prática do surf”. 

Assim, a linguagem que usamos e a necessidade 
de mais ou menos explicações, também determinam 
a estrutura do trabalho/ideia que vamos apresentar.

Público - alvo
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PLANEAR

Processo Criativo
As ideias – como arranjá-las e escolher a 
melhor.

Ver o que há

Independentementeda sua lista de objectivos, 
haverá já muita informação online sobre o tema em 
causa.

Tomemos o exemplo do jornal escolar. Pode não 
existir o jornal da sua escola, mas há muitos jornais 
escolares online.

Ver o que já está feito, deixar o nosso gosto pes-
soal decidir o que gostamos ou não gostamos, 
em toda a informação que estamos a ver, é uma 
forma de ajudar a formar a ideia. “Gosto dis-
to, vou tentar fazer algo semelhante”; “Isto não 
me parece bom, vou tentar não cometer este 
erro”; “Esta ideia é boa, mas acho que pode-
ria ser melhorada se fosse um pouco diferente”.

Portanto, pesquise (Pesquisar). Vai certamente en-
contrar muita informação válida e muito informação 
que pode não parecer interessante. 

Nesta fase do campeonato não devem existir preo-

cupações com questões de detalhe. Veja, navegue         
cal mamente, conheça   o  que  outros já fizeram, observe  
e retenha o que lhe agrada e o que não lhe agrada.

A ideia começa a tomar forma. Ainda não são os 
alicerces completos, mas para lá caminhamos. 

Brainstorming

As pessoas que nos rodeiam, e de quem gostamos 
ou respeitamos, podem também ser uma boa fonte 
de ideias. Quantas ideias não surgiram de uma con-
versa de amigos no café ou de uma reunião. Basta 
perguntar e pedir ajuda a colegas, amigos e familiares. 

Se trabalhamos em grupo ou em equipa, podemos 
provocar a criatividade e as ideias. Uma das técni-
cas mais conhecidas desta “reuniões criativas” cha-
ma-se “braisnstorming”, palavra que, traduzida para 
português, resulta numa “tempestade de cérebros”. 

Se estiver a fazer um trabalho individualmente, não 
se preocupe, siga do mesmo modo as regras que 
apresentamos de seguida. 
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PLANEAR

E como é que se põe a funcionar um 
“brainstorming”?

•  Apresente a lista de objectivos de forma clara para 
que não restem quaisquer dúvidas;

•  Quanto maior a diversidade das pessoas do grupo 
mais rico será o resultado; 

•  Um participante pode e deve aproveitar uma ideia 
(de outra pessoa) para acrescentar algo. (Construção 
de ideias com base nas ideias dos outros.);

•  Mantenha a discussão focada no tema. Não per-
mita desvios ao tema central;

•  Não permita quaisquer críticas a qualquer ideia. 
Num “brainstorming” TODAS as ideias são válidas, 
por mais irreais ou irrealizáveis que possam 
parecer;

•  Incentive um ambiente agradável, simples, infor-
mal, pouco competitivo e não crítico, entre os par-
ticipantes;

•    Não perca muito tempo com uma ideia. Vá seguin-
do em frente na lista e volte atrás se necessário. 

Processo Criativo
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PLANEAR

Organização

Qual a forma mais eficaz de expor a 
ideia?

Tão importante como uma boa ideia, é a forma como 
a apresentamos.
Muitas vezes, uma boa ideia, mal apresentada, es-
morece, perde a graça e a garra, perde o sentido.

E também nesta área, no meio é que está a vir-
tude, no equilíbrio. Nem “acessórios” de mais nem 
de menos, nem palavras a mais nem a menos. 
Como na culinária, q.b. (ou seja, quanto baste).
Para apresentar e estruturar convenientemente uma  
ideia temos de saber o que pretendemos transmitir.

Começamos por identificar quais as perguntas a 
que vamos responder, ou qual o problema que 
temos para resolver, ou qual a abordagem por 
que vamos optar sobre um determinado tema.

Ao enunciarmos estas questões, estamos a orga-
nizar a estrutura do documento, estamos a criar o 
índice, que será a espinha dorsal do nosso trabalho.

Organize e estruture o seu trabalho como se es-
tivesse a contar uma história. Qualquer ser humano 
gosta de uma história, por isso é que gostamos de ir 
ao cinema. Gostamos que nos contem uma história. 

E uma história é constituída por uma introdução 
(em que somos contextualizados, onde nos dão a 
conhecer as personagens, os locais, etc.), um de-
senvolvimento  (onde se desenrola a história que 
nos estão a contar, onde são feitas perguntas, co-
locadas ou apresentadas questões), e uma con-
clusão (onde se resumem as ideias principais).

Resumindo: 

Introdução - Dizer o que se vai dizer.

Desenvolvimento - Dizer o que tem a dizer.

Conclusões – Resumir o que se disse.
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PLANEAR

Limites do processo criativo

Muitas vezes, um trabalho que pretende atingir um 
objectivo muito concreto, falha. E falha porque no 
meio do processo criativo começam a surgir mais 
ideias, e mais problemas, e mais soluções, e mais 
informações.

Criar é também saber exactamente onde é que se 
deve parar. Quando é que a nossa ideia já está ex-
posta. Quando é que começamos a extravasar e a 
divagar para algo que, podendo ser muito interes-
sante, não contribui para o nosso objectivo final.

O resultado final de um trabalho deste tipo é catastró-
fico. Demora mais tempo, consome mais recursos e 
no final, há demasiada informação. 

Saber distinguir o essencial do supérfluo é talvez a 
tarefa mais difícil do processo criativo.

Também aqui existem técnicas que nos ajudam a 
decidir. 

A mais óbvia é pedir ajuda a alguém. Uma pessoa 
que seja parecida com o nosso “público”. Mostrar-lhe 
a estrutura do trabalho, e depois ouvi-la. Perguntas 
de que nem sequer nos lembrámos são levantadas. 
Pode ser um processo duro, afinal de contas, quem 
é que gosta de ouvir críticas? Mas as críticas podem 
ser construtivas, podem (e devem) servir de guias 
para o nosso trabalho.

No processo criativo, os limites não são importantes, 
são fundamentais. Imagine um jogo de futebol. Se 
não existissem as linhas de marcação do campo (os 
limites), não haveria jogo, certo? 
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PESQUISAR

Como e onde encontrar o conteúdo certo (textos, 
fotos, vídeos)

Agora, que a ideia está definida, os objectivos tra-
çados e o alvo identificado, chega uma das partes 
mais divertidas do trabalho, a parte do trabalho em 
que a Internet pode dar uma ENORME ajuda. Está 
tudo na Internet. E no meio de tudo, onde encontrar 
exactamente o que precisamos?

A dificuldade é mesmo essa. Encontrar a informação 
certa. Em português, de Portugal.

A Internet é uma fonte de informação à escala mun-
dial. São milhares e milhares de computadores, que 
armazenam todo o tipo de informação que está lá, 
disponível, à espera de ser encontrada e utilizada. 

Como chegar lá?

Vamos ensinar a pesquisar melhor e mais rápido! 
Mostramos alguns conceitos básicos, damos alguns 
exemplos e depois é só pesquisar! 
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PESQUISAR

Palavras - chave ( keywords )

O SAPO possui um avançado motor de pesquisa 
que permite, através de certos parâmetros, encon-
trar a informação pretendida com grande precisão.

Para que o SAPO encontre a informação na sua 
base de dados, temos de especificar palavras-chave 
(keywords). Por exemplo, “desporto”, “jornais”, “edu-
cação” podem ser palavras-chave.

O SAPO faz algum tratamento às palavras-chave in-
troduzidas. Nomeadamente, não há distinção entre 
maiúsculas ou minúsculas, e o uso de acentuação 
é indiferente. Ou seja, “EdUcação” é o mesmo que 
“EdUcacao” ou “educacao”. Tipicamente, as pala-
vras-chave são introduzidas em minúsculas e sem 
acentuação.

Palavras-chave com menos de três caracteres não 
são consideradas como termos relevantes para a 
pesquisa, com a excepção de pesquisas mundiais.

Funcionalidades

Quando se faz uma pesquisa por “jornal diário”, o 
SAPO encontra todos os registos que possuam si-
multaneamente as palavras “jornal” e “diario”, ou 
seja, as palavras podem não estar necessariamente 
juntas nem pela ordem em que são introduzidas.

A pesquisa mundial permite encontrar frases tal 
como introduzidas, de modo a que uma frase 
represente apenas uma palavra-chave,  envolvendo 
as palavras com aspas. Por exemplo: se pesquisar-
mos “jornal diario”, apenas encontramos os registos 
com a frase “jornal diario”, tal como está escrita. 
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PESQUISAR

Tipos de pesquisa
Por defeito, o resultado da pesquisa apresen-
tado é um resumo da pesquisa pelas palavras-
-chave escolhidas em diversas áreas. 
Quando clicamos nos separadores de cada uma 
das áreas, o SAPO apresenta apenas os resul-
tados de cada uma delas. 
Actualmente podemos efectuar pesquisas nas 
áreas seguintes:

- Portugal: pesquisa em sites portugueses;

- Mundial: pesquisa em sites nacionais e inter-
nacionais, utilizando o motor de pesquisa do 
Google; 

- Notícias/Blogs: pesquisa de notícias, publica-
das em jornais online e em blogs;

- Imagens: imagens indexadas pelo motor de 
pesquisa do Google;

- Produtos: artigos à venda no Shopping SAPO; 

- Directório: pesquisa de sites indexados por 
temas no Directório do SAPO.
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PESQUISAR SELECCIONAR

Existem conjuntos de expressões e operadores bo-
leanos que ajudam a chegar mais rapidamente aos 
resultados que realmente pretendemos encontrar. 

Aqui mostramos como podemos melhorar as pesqui-
sas no SAPO. 

Expressões

Sites.pt

Se na pesquisa mundial pesquisar com a ex-
pressão site:pt a seguir às palavras-chave, só irá 
obter sites que acabem em .pt. Por exemplo: coloca 
gato site:pt e encontra sites que contêm a palavra 
gato e cujo url termina em .pt. Ou seja, sites de Por-
tugal.

Também podemos usar esta expressão para encon-
trar sites de outros países, por exemplo site: es (Es-
panha).

PDF

Para pesquisarmos documentos em formato pdf, 
basta colocarmos a palavra pretendida seguida de fi-
letype:pdf. Por exemplo: se colocarmos gato filetype:
pdf, encontramos links para documentos em formato 
pdf que contêm a palavra gato.

Podemos usar esta expressão para encontrar outro 
tipo de documentos, por exemplo, filetype:doc (docu-
mentos em Word) ou filetype:swf (flash).

 “”
Se quisermos pesquisar qualquer conjunto de pa-
lavras, devemos usar aspas, por exemplo: “Gil Vi-

cente”. Estas transformam a frase em uma palavra-
-chave e indicam ao motor de pesquisa que apenas
estamos interessados em documentos que contenham
as duas palavras, nesta ordem específica.

Booleanas

 +
Se pesquisarmos por Gil + Vicente encontramos 
documentos com ambas as palavras. Obtemos o 
mesmo resultado se colocarmos apenas Gil Vicente, 
visto que esta função está incluída na pesquisa por 
defeito.

 -
Devemos usar o sinal – (subtracção), se queremos 
excluir as páginas Web que contenham as palavras 
ou frases especificadas. Por exemplo, queremos en-
contrar documentos que contenham a palavra figo, 
mas não queremos que esta pesquisa inclua Luís 
Figo. Só precisamos de colocar Figo –“Luís Figo”. 
Atenção: é preciso colocar um espaço entre a 1ª pa-
lavra-chave e o sinal de menos e este deverá estar 
logo antes da 2ª palavra.

 *
Se colocarmos um conjunto de letras seguidos de 
um *, encontramos páginas que contêm palavras 
que começam por essas letras. Por exemplo, se 
escrevermos univ* encontramos documentos com 
Universo, Universidade, Universitário, entre outras 
palavras. Esta função boleana é ideal quando não 
sabemos exactamente como se escreve a palavra 
que pretendemos pesquisar.

Funções Booleanas e Expressões
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SELECCIONAR

Fontes de informação
Como distinguir as boas das más fontes 
de informação.

Pronto, já sabemos procurar. E agora? Sim, porque 
nisto da informação, a qualidade tem muito que se 
lhe diga.

Mas é fácil, usam-se exactamente os mesmos crité-
rios que usamos fora da Internet. É só uma questão 
de prática.

Primeira regra – de quem é a responsabilidade da 
informação?

A boa informação identifica SEMPRE a sua origem. 
Informação sem autor é má informação ou, pelo me-
nos tem menos garantias de ser informação de quali-
dade.

Se a responsabilidade da informação é de uma en-
tidade conhecida e credenciada, então, provavel-
mente, é informação credível. Por exemplo, se for 
informação que exista no SAPO, assinada pelo 
SAPO ou por um dos seus parceiros, a informação 

Não é objectivo.

Quanto mais adjectivos existem num texto, menos 
objectivo é esse texto. Portanto, se for um texto 
maravilhoso, esplendoroso, magnífico, apoteótico, 
extraordinário, belíssimo e de refinadíssimo gosto, 
esqueça. A não ser que ande à procura de poesia e 
nesse caso, a subjectividade é fundamental.

Se quer saber se a informação que recolheu tem 
qualidade ou não, basta seguir estas três regras, e 
aplicar o seu bom senso. Na dúvida pergunte sem-
pre, a um professor, aos pais, aos amigos. 

é fidedigna.

Se a informação estiver numa página pessoal, sem 
identificação do autor ou das fontes a que este recor-
reu, então é mais arriscado confiar nessa informa-
ção.

Segunda regra – tem erros de ortografia, 
gramática, construção ou concordância? Não é               
credí vel.

Um dos critérios mais simples é a própria língua por-
tuguesa. Um autor que não sabe usar a língua por-
tuguesa não é um autor credível, logo, a informação 
não é de confiança. Exclua-se.

Terceira regra – É excelente e lindo?                   
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SELECCIONAR SELECCIONAR

No entanto, online, são muitos mais os casos em 
que a informação pode ser usada do que os casos 
em que não se pode usar a informação. Seja como 
for, certifique-se de que o autor original permite a re-
utilização do seus conteúdos.

Quando se recolhe informação de algo já publicado, 
é importante referir a fonte, a origem de onde reco 

Na Internet não é diferente, apenas é mais fácil, 
porque existem os links. 

Ao terminar um trabalho deverá ter uma área espe-
cífica, onde identifica TODAS as fontes a que recor-
reu para recolher informação, e uma vez que está na 
Internet, nada mais fácil do que colocar um link, de 
forma a que quem esteja a ver o seu trabalho possa 
avaliá-lo também através das fontes que consultou.                 

Seja num blog, porque usou uma foto de outra pes-
soa, numa homepage, onde tem um texto de outra 
pessoa, seja num trabalho onde usou informação de 
um site, refira as fontes, e já agora, faça-o com sim-
patia e coloque um link para as suas fontes, para os 
sites de onde recolheu a informação.

Usar os conteúdos seleccionados sem 
cair na tentação de copiar. Referir as fon-
tes de informação.

Há diferença entre recolher informação, trabalhá-
la, estruturá-la, acrescentando-lhe algo de novo, e 
copiar descaradamente um texto, uma ideia, apre-
sentando-a como nossa.

A primeira é trabalho, a segunda é cópia, e as cópias 
são para as crianças.

Quando alguém inventa qualquer coisa, passa a ser 
o seu dono. Seja um objecto, um texto, uma foto, 
uma ideia. Não podemos entrar num museu e levar 
um quadro, da mesma forma não podemos entrar 
num site e levar uma ideia. Mas podemos à saída do 
museu comprar um postal onde está esse quadro, 
emoldurar o postal e colocá-lo na nossa sala. 

Quando encontramos informação que nos pode ser 
útil, devemos em primeiro lugar verificar se o seu au-
tor permite que a informação seja usada. Quando 
não é permitida a utilização da informação, existe 
habitualmente um “Direitos reservados” visível em 
todas as páginas. Nesse caso, deve procurar outros 
conteúdos que possam servir os seus objectivos.

lhemos essa informação. Também as fontes de in-
formação que usamos ajudam a credibilizar o nosso 
trabalho. Se recolhemos informação de um livro, no 
final do trabalho devemos referir o livro e os seus au-
tores. Se usamos uma foto para ilustrar um trabalho, 
devemos referir o nome do fotógrafo bem como o 
livro/manual/catálogo de onde retirámos essa infor-
mação.

Fontes de informação

13/90



SELECCIONAR

Como referenciar fontes
Página Web de uma empresa, uma organização ou 
universidade:

APELIDO, Nome. Título do documento ou notícia. 
Acedido em: dia, mês, ano, Nome do website: url.

Ou seja:

GUERRINHA, Paulo M. Um final em grande! Ace-
dido em: 12, Agosto, 2006. Rock In Rio Lisboa: 
h t t p : / / r o c k i n r i o - l i s b o a . s a p o . p t / a r t i g o .
html?id=672624&lang=pt
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EDITAR

É verdade que uma imagem vale mais do que mil pa-
lavras, por isso é natural que queira incluir algumas 
no seu site.

Talvez essas imagens tenham sido tiradas com a 
sua câmara digital ou sejam imagens que tem no 
seu computador. Em ambos os casos vai querer 
optimizá-las para que o seu download seja rápido, 
porque ninguém vai querer esperar mais que alguns 
segundos por ela.

Tendo em conta que são precisos cerca de 1024
bytes (1KB) de informação para ter um ecrã cheio
de texto e que um pequeno ícone de imagem pesa
9KB, fica fácil perceber a importância de optimizar
imagens.

A utilização indiscriminada de imagens, por mais 
cool que sejam, pode saturar os utilizadores ao pon-
to destes se irem embora.
Assim, o que fazer? COMPRIMIR para que as ima-
gens fiquem mais leves e demorem menos tempo a 
carregar.

Principais formatos aceites na Web:

GIF - Graphic Interchange Format. É um dos mais 
antigos formatos, é também um dos mais populares 
e versáteis. Ideal para logótipos, desenhos e mate-
rial similar com cores sólidas.

JPEG – Joint Photographic Experts Group. Pode 
ajustar a imagem reduzindo 10% ou 5% e esta quase 
não perde qualidade. O formato JPEG é ideal para 
fotografias e outras imagens com muita informação 
de cor como por exemplo degrades, mas não acon-
selhável para comprimir imagens com grandes áreas 

de cor sólida como os logótipos.

Na área dedicada ao Picture Manager e Photoshop, 
vai aprender a comprimir bem. O ideal é tentar que 
as suas imagens tenham entre 30 a 100 KB por 
imagem. Tenha atenção ao tamanho das imagens se 
quiser colocar várias numa mesma página ou enviá-
las por e-mail.

Tente não exceder os 100 KB para o total de ima-
gens numa página: quase sempre impossível mas 
ainda assim um ideal a manter!

Imagem

15/90



EDITAR

Imagem no Picture Manager
O Picture Manager é um programa de software que 
vem integrado no pacote Microsoft Office e que lhe
permite editar imagens de uma forma super simples. 
Com este software pode ajustar a claridade e  
contraste, alterar a cor, cortar, rodar, redimensionar e
comprimir imagens. Tudo o que precisa para inserir 
imagens no seu site ou blog!

De seguida encontra orientações passo a passo
para trabalhar rapidamente com este programa. 

Passo 1. Abrir o Programa

1. Clique em Start > Programs > Microsoft Office > 
Microsoft Office Tools > Microsoft Office Picture 
Manager para abrir o Interface do Picture Manager.

Passo 2. Criar Shortcuts 

Em vez de ter que abrir as imagens individualmente, 
o Picture Manager, permite-lhe adicionar Shortcuts 
(atalhos) para que possa ver todas as suas imagens 
ao mesmo tempo no écran, o que pode acelerar bas-
tante o processo. Depois de ter criado os Shortcuts 

não precisa de estar sempre a abrir as imagens cada 
vez que quer utilizar o programa.

É criado automaticamente um Shortcut chamado My 
Pictures dentro da pasta My Documents (normal-
mente aparece no Desktop - ambiente de trabalho, 
mas caso não exista, pode ser acedida a partir do 
Start Menu). Para além deste, pode também criar 
os seus Shortcuts.

Para criar um shortcut:

1. Clique em Add a new picture shortcut no painel 
Getting Started

2. Localize o Folder onde tem as imagens e clique 
Add. Agora o novo shortcut folder já aparece.

Passo 3. Visualizar Imagens 

No Picture Manager pode visualizar as imagens de 
três formas: 
Thumbnail View – as imagens aparecem em         
miniatura
Filmstrip View – as imagens aparecem numa barra 
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na parte de baixo do ecrã mas a imagem seleccio-
nada é aumentada e mostrada na parte de cima do 
écran. Este modo permite-lhe navegar entre as ima-
gens de uma forma muito prática e rápida. 
Single Picture View – mostra apenas a imagem se-
leccionada. 

Para alterar a forma de visualização:

1. Seleccione o shortcut folder que quer ver.
2. Clique no botão View para o modo que deseja 
– situado no topo da área de visualização das ima-
gens.
3. Os botões Next e Previous, no final do écran, po-
dem ser utilizados para navegar entre imagens para 
qualquer dos modos de visualização seleccionados. 

Thumbnail View              Filmstrip View                  
Single Picture View  

Passo 4. Aumentar uma Imagem – Zoom 

Pode aumentar a visualização de uma imagem de 
duas formas: 

1. Clique na seta Zoom na barra de menus 
Standard e na lista de valores que aparece escolha 
a percentagem de zoom.

 

2. Utilize a barra de Zoom, no final do ecrã para 
aumentar ou diminuir manualmente a percentagem 
de zoom. 

Passo 5. Editar Imagens

Agora que o interface do programa já é familiar, 
podemos passar ao que interessa: editar as ima-
gens.

Para editar uma imagem:

1. Seleccione a imagem a editar;
2. Seleccione Single Picture View (modo de                      
visualização);
3. Clique em Edit Pictures no painel Getting Started.

5.1 Gravar uma imagem

Antes de começarmos a editar as imagens, é boa 
prática preservar a imagem original e gravar a ima-
gem editada com um nome diferente. Pode sempre

Imagem no Picture Manager
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querer voltar à imagem original e dar-lhe novo trata-
mento. Se não fizer isto, perde a imagem original 
que é substituída pela editada. 

Para gravar uma imagem:

1. Clique em File > Save As para ter acesso à janela 
Save As.

2. Na caixa File name, escreva um novo nome para 
a imagem editada. Imagens para serem utilizadas na 
Web devem ser gravadas sem espaços, acentos ou 
caracteres especiais no nome.
3. Clique no botão Save. A janela Save As fecha-se 
e a imagem está gravada.

A partir daqui basta fazer Save que as edições vão 
sendo gravadas neste novo ficheiro. Sempre que 
quiser gravar algum passo de uma edição, volte a 
fazer Save As com um nome diferente.

5.2 Rotate e Flip

Pode rodar (rotate) as imagens para a esquerda, 
para a direita e também pode voltá-las (flip) na hori-

zontal e na vertical. Esta função é útil quando temos 
fotos que foram tiradas com a câmara na vertical por 
exemplo. Não nos podemos esquecer que as pes-
soas vão ver o nosso site num écran de computador 
(na maioria dos casos) e não podem “rodar” o ecrã 
como fazem com uma foto em papel por exemplo.

Para rotate/flip uma imagem:

1. Seleccione a imagem a editar.
2. Seleccione Single Picture View (modo de visua-
lização).
3. Clique em Rotate and Flip no painel 
Edit Pictures

4. Faça as mudanças que pretende: rodar para a es-
querda (Rotate left), para a direita (Rotate right) ou 
escolhendo um grau de rotação (By degree).

Depois de aplicadas as alterações à imagem, estas 
podem ser gravadas seleccionando File > Save ou 
rejeitadas seleccionando Edit > Discard Changes.

Imagem no Picture Manager
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Exemplo:
Imagem original

Rotate Left

Flip Horizontal

5.3 Claridade e Contraste

A claridade (brightness) e o contraste (contrast) po-
dem ser alteradas de forma a melhorar a legibilidade 
de uma imagem.  

Para ajustar:
1. Seleccione a imagem a editar.
2. Seleccione Single Picture View (modo de                
visualização).
3. Clique Brightness and Contrast no painel Edit 
Pictures 
4. Clique em More para mais opções.

5. Clique no botão Auto Brightness se quiser cor-
rigir automaticamente os níveis, ou ajuste os vários 
itens manualmente.

Depois de aplicadas as alterações à imagem, pode 
gravar seleccionando File > Save ou rejeitadas se-
leccionando Edit > Discard Changes.

Exemplo:
Imagem original

Imagem no Picture Manager
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Mais Brightness e mais Contrast

5.4 Alterar a Cor

A cor de uma imagem também pode ser alterada. 
Assim consegue alguns efeitos engraçados de modo 
muito rápido.

Para alterar a cor:
1. Seleccione a imagem a editar.
2. Seleccione Single Picture View (modo de 
visualização).
3. Clique em Color no painel Edit Pictures 

4. Clique no botão Enhance Color, clique depois 
numa área branca da imagem para automaticamente 
equilibrar as cores, se preferir pode ajustar os vários 
itens manualmente alterando os valores para Hue e 
Saturation settings.

Depois de aplicadas as alterações à imagem, estas 
podem ser gravadas seleccionando File > Save ou 
rejeitadas seleccionando Edit > Discard Changes.

5.5 Cortar uma Imagem

Por vezes o que nos interessa numa imagem é mes-
mo um detalhe. Podemos também querer alterar o 
enquadramento. Chama-se a esta função Crop (cor-
tar). 

Para Cortar uma imagem:
1. Seleccione a imagem a editar.
2. Seleccione Single Picture View (modo de visua-
lização).
3. Clique em Crop no painel Edit Pictures 

Imagem no Picture Manager
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4. Pode definir o Aspect Ratio (rácio, isto é a pro-
porção entre altura e largura da imagem) se quiser 
manter a proporção da imagem, ou então escolher 
None. 
5. Pode inserir o número de pixels que deseja elimi-
nar nas caixas Crop Handles ou então arrastar os 
cantos que aparecem em cima da imagem até en-
contrar o enquadramento desejado. 

6. Clique no botão OK. A versão cortada da imagem 
está agora disponível.
(nota: se quiser manter a imagem original, e se 
ainda não o fez, não se esqueça de fazer um Save 
As)

Depois de aplicadas as alterações à imagem, estas 
podem ser gravadas seleccionando File > Save ou 
rejeitadas seleccionando Edit > Discard Changes.

5.6 Redimensionar uma imagem

Quando trabalhamos para a Net não nos podemos 
esquecer que quanto mais pesada é uma imagem, 
mais tempo demora a carregar. Assim, é convenien-
te redimensionar as imagens para o tamanho que é 
mesmo necessário. Por outro lado, imagens “gigan-
tes” podem por vezes não ser vistas de uma vez só 
no écran, sendo necessário fazer scroll.

Existem três formas de redimensionar (Resize) uma 
imagem. Pode utilizar os itens pré-definidos (pré-de-
fined), que são dimensões definidas pelo programa, 
pode definir manualmente a altura e largura (Cus-
tom width x height ) ou pode ainda definir uma per-
centagem da altura e largura originais (Percentage 
of original width and height).

Para redimensionar uma imagem:
1. Seleccione a imagem a editar.
2. Seleccione Single Picture View (modo de 
visualização).
3. Clique Resize no painel Edit Pictures 

Imagem no Picture Manager

21/90



EDITAR

4. Ajuste o tamanho que pretende dar à imagem.
5. Clique no botão OK.

Depois de aplicadas as alterações à imagem, estas 
podem ser gravadas seleccionando File > Save ou 
rejeitadas seleccionando Edit > Discard Changes.

5.7 Comprimir uma imagem

Comprimir (compress) uma imagem é fundamen-
tal quando queremos reduzir o seu peso, para que 
possa ser utilizada na Internet. É importante que as 
pessoas consigam ver as nossas imagens sem ter 
que esperar muito tempo para que elas carreguem 
na página ou no blog. 

Para comprimir uma imagem:
1. Seleccione a imagem a editar.
2. Seleccione Single Picture View (modo de visual-
ização).
3. Clique em Compress Pictures no painel Edit 
Pictures.

4. Seleccione a opção de compressão Web Pages, 
se deseja publicar estas imagens online.
5. Clique no botão OK.

Depois de aplicadas as alterações à imagem, estas 
podem ser gravadas seleccionando File > Save ou 
rejeitadas seleccionando Edit > Discard Changes.

6. Conclusão

Depois de editar as suas imagens, está pronto para o 
passo seguinte: inseri-las no seu site ou blog. (capí-
tulo Publicar, sub-capítulo Upload de ficheiros).

Vamos a isto! 

Veja Templates e Registar Área de Fotos para sa-
ber como inserir as suas imagens online

Imagem no Picture Manager
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Imagem no Photoshop
O software Adobe Photoshop CS2 é o padrão profis-
sional em edição de imagens e líder no mercado das 
imagens digitais. É o software de edição de imagens 
mais completo e sofisticado. Neste e-book vamos 
aprender algumas acções básicas de edição de ima-
gens para a Web em Photoshop, não vamos poder 
explorar todas as suas potencialidades. 

Integrado no pacote Photoshop existe o programa 
ImageReady que se destina a comprimir imagens 
para a Web. Também vamos aprender a comprimir 
bem!

Depois de abrir o programa, pode ficar assustado 
com tantos menus e comandos. Muitos destinam-se 
a uma utilização bastante profissional de tratamento 
de imagem e não são relevantes neste contexto. 
Neste e-book, vamos ver todos os comandos que 
precisa para preparar as suas imagens para a Web 
da forma mais simples possível.

1.  Abrir imagens 

Abrir os seus ficheiros de imagem é a primeira coisa 
que precisa de fazer.

1. Escolha File > Open.
2. Escolha o nome do ficheiro que quer abrir. Se o fi-
cheiro não aparecer, seleccione a opção que mostra 
todos os ficheiros, para Windows: Files of Type; 
para Mac OS: Show.

Se quiser criar uma nova imagem (por exemplo a 
partir de um print-screen que tenha feito da Net), uti-
lize o comando New.

1. Escolha File > New.
Na janela seguinte pode definir o nome da imagem e 
as suas dimensões (width-largura e height- altura). 
Se não definir dimensões, o Photoshop assume as 
dimensões da imagem que aí vai colar, no caso de 
ter feito um print-screen, ou as dimensões da última 
imagem que abriu em Photoshop.

Gravar o original
Antes de começar a transformar a sua imagem, é 
melhor gravar uma cópia do original. No Photoshop 
apenas tem um UNDO (ou seja só pode voltar atrás 
uma vez). É muito fácil perder o original.

Existem inúmeros menus neste pro-
grama que podem ser abertos e fecha-
dos, mas um é fundamental: a barra de 
ferramentas.
Esta barra está sempre visível e contém 
comandos importantes como as ferra-
mentas de selecção de partes da ima-
gem, a ferramenta de crop, as funções 
de zoom, a definição das cores de fore-
ground e background que mais à frente 
iremos explorar.

2.  A barra de ferramentas 
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3.  Tamanho das Imagens

Não nos podemos esquecer que na Web impera a 
economia: imagens de grande dimensão pesam mais 
e os tamanhos dos ecrãs também são limitados.

É melhor ajustar o tamanho e resolução de uma ima-
gem antes de começar a editá-la.

1. Escolha Image > Image Size
2. Escolha a Width (largura): pode inserir valores nu-
méricos. 

Se este símbolo        estiver activo quer dizer que 
o programa vai automaticamente ajustar a Height 
(altura) proporcionalmente à largura que inseriu. É 
aconselhável manter as proporções da imagem. Mas 
se não o quiser desseleccione o ticker Constrain 
Proportions no final da janela.

Document size: define a dimensão da imagem para 
efeitos de impressão.

Resolution: é a definição da imagem (pixels per 
inch), e quer dizer quantos pontos existem por po-
legada o que define a maior ou menor definição da 
imagem. O papel tem 300 pontos por polegada en-

quanto o ecrã tem apenas 72. 
Assim, sempre que quiser trabalhar uma imagem 
para a Web, deve alterar a Resolution para 72 dpis 
(dots per inch).

4.  Canvas Size

A função Canvas Size permite adicionar ou remover 
área de trabalho em redor da imagem. Pode também 
utilizar esta função para cortar uma imagem redu- 
zindo a área em seu redor. 
No Photoshop existem várias opções para o fundo a 
atribuir à área de trabalho adicionada/alargada; se a 
imagem tem fundo transparente, a área adicionada 
será também transparente.

Para alterar o Canvas Size:

1. Escolha Image > Canvas Size

2. Pode optar por um dos seguintes procedimentos:
- Introduza as dimensões da área de trabalho nas 
caixas de altura (height) e largura (width). Escolha 
a unidade de medida que pretende nas opções que 
se encontram ao lado dessas caixas.
- Escola Relative e introduza, tendo em conta a uni-
dade de medida, o valor através do qual vai aumen-
tar ou diminuir a área de trabalho. Para diminuir in-
troduza valores negativos.

3. Na opção Anchor, clique num dos quadrados 
para indicar o posicionamento da imagem existente 
na nova área de trabalho.

4. Escolha uma opção no menu Canvas Extension 

Imagem no Photoshop
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Color:

- Foreground para preencher a nova área 
de trabalho com a actual cor foreground
- Background para preencher a nova área 
de trabalho com a actual cor de fundo.
(As cores de Foreground e Back-
ground podem ser editáveis na barra 
de ferramentas – imagem  – se cli-
car duas vezes na cor abre a janela 
onde pode escolher a cor pretendida; 
se quiser alternar background e fore-
ground clique no ícone com duas setas)
- Branco, Preto ou Cinzento para    
preencher a nova área de trabalho com a 
cor escolhida
- Pode também escolher a cor da nova 
área de trabalho através da ferramenta 
Color Picker 

5. Clique OK.

Imagem no Photoshop
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5. Rotate Canvas 

A função Rotate Canvas (dentro do menu Image) 
permite rodar e voltar uma imagem. 

Para rodar e voltar uma imagem (inteira):

Escolha Image > Rotate Canvas, escolha uma das 
seguintes opções do submenu:
- 180º - roda a imagem em “meia-volta” / “cabeça 
para baixo”;
- 90º - CW roda a imagem 90º para a direita (clock-
wise);
- 90º - CWW roda a imagem 90º para a esquerda 
(counterclockwise);
- Arbitrary – roda a imagem de acordo com o ângulo 
especificado. 

Pode ainda escolher através das opções CW e CWW 
se roda para a direita ou esquerda.
- Flip Canvas Horizontal – volta a imagem horizon-
talmente, no eixo vertical
- Flip Canvas Vertical – volta a imagem vertical-
mente, no eixo horizontal.

6.  Ajustar as cores e o contraste

Não se esqueça de gravar uma versão antes de 
começar. Escolha File > Save As e dê um novo 
nome. 

Adjust color (Cor) 
Alterar a cor de uma imagem, pode ser uma forma 
muito rápida de criar várias versões da mesma ima-
gem.

Para ajustar a cor:
1. Escolha Image > Adjustments > Color Balance
2. Mova as barras para alterar a cor
3. Vá vendo o que acontece à imagem e quando es-
tiver satisfeito, clique OK. 

Ajustar  Brightness and  Contrast

A claridade (brightness) e o contraste (contrast) 
podem ser alteradas de forma a melhorar a legibili-
dade de uma imagem. Também pode fazer uns efei-
tos engraçados de modo muito rápido.

Imagem no Photoshop
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7. Fazer Crop 

Fazer crop é o processo de remover partes de uma 
imagem para criar focus ou para melhorar uma com-
posição.

Fazer crop usando a ferramenta Crop: 

1. Seleccione a ferramenta Crop na barra de ferra-
mentas -  

2. Se necessário use a barra de opções para              
estabelecer as opções da ferramenta Crop: ponha o 
rato por cima do ícone crop e clique no botão esquer-
do. Passado uns segundos, aparecem as opções 
de crop que são: rectagular, elipse, single row e 
single column, para várias formas de seleccionar o 
fragmento a eliminar.

3. Arraste o rato por cima da parte da imagem que 
quer manter para seleccionar/criar uma área rodeada 

por linha divisória (marquee)

4. Se necessário, ajuste essa área (marquee):
- para mover a área para outra posição, posicione o 
rato/ponteiro dentro da parte seleccionada e arraste 
para onde pretende.
- para redimensionar o marquee arraste os nós da 
linha divisória. Para respeitar/manter as proporções 
carregue na tecla Shift enquanto arrasta o nó de um 
dos cantos do marquee.
- para rodar a marquee  posicione o ponteiro fora da 
linha divisória, este transforma-se numa curved ar-
row, e arraste.

5. Quando estiver satisfeito com a sua selecção, volte 
a clicar no símbolo crop na barra de ferramentas.

A imagem está cortada

Imagem no Photoshop
Para ajustar brightness and contrast:

1. Escolha Image > Adjustments > Brightness 
and Contrast
2. Mova as barras para acrescentar ou retirar lumino-
sidade e contraste
3. Vá vendo o que acontece à imagem e quando es-
tiver satisfeito, clique OK.
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8. Comprimir para a Web (GIF, JPEG) 
save for the Web (settings e cores) 

Agora que a imagem já está nas dimensões pre-
tendidas e com a cor e contraste ajustados, só falta 
mesmo comprimi-la para que carregue o mais rápido 
possível no site ou blog. É aqui que entra o Image 
Ready.

Sobre a compressão /optimização de imagens 

Quando preparamos imagens para a Web ou para 
outros meios online, temos de conseguir um com-
promisso entre a qualidade da imagem e o peso do 
ficheiro.

Podemos comprimir de duas formas:

Para uma optimização básica:
O comando Save As permite gravar uma imagem 
como ficheiro GIF, JPEG. Dependendo do formato 
do ficheiro pode especificar a qualidade da imagem, 
transparência ou opacidade do fundo, color display, 
ou método de download.

Para uma optimização mais precisa:
Pode utilizar as funcionalidades de optimização do 
comando Save For Web (Salvar para Web que abre 
o programa Image Ready) para pré-visualizar as 
imagens optimizadas em diferentes formatos com 
atributos diferentes. 

8.1 Comprimir imagens com o comando 
Save As

Save (Gravar) – Guarda alterações feitas no 

ficheiro. No Photoshop o ficheiro é guardado no for-
mato corrente.
Escolha File > Save

Save As (Gravar Como) – Guarda uma imagem 
numa localização diferente, com um nome diferente 
e num formato diferente. 

Escolha File > Save As
Escreva o nome do ficheiro ou escolha a sua 
localização.
Clique Save

Para guardar um ficheiro num formato diferente
Proceda de uma das seguintes formas:
Escolha File > Save As

Formatos aceites na Web:

Para gravar um ficheiro em formato GIF:
Pode utilizar o comando Save As para gravar ima-
gens em RGB, Indexed Colour, Grayscale ou Bitmap 
directamente em formato CompuServe GIF (também 
conhecido como GIF). A imagem é automaticamente 
convertida em modo Indexed Colour.

1. Escolha File > Save As, em seguida escolha 
CompuServe GIF no menu Format

2. Para imagens RGB, aparece a janela Indexed Co-
lour, especifique as opções de conversão e clique 
OK.

3. Seleccione uma linha de ordem (row order) para o 
ficheiro GIF e clique OK:
Normal – faz aparecer a imagem no browser apenas 

Imagem no Photoshop
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Para gravar um ficheiro em formato JPEG:
Pode utilizar o comando Save As para gravar ima-
gens CMYK, RGB e Grayscale em formato JPEG. 
Este formato comprime o tamanho do ficheiro através 
da selecção de informação a rejeitar.
1. Escolha File > Save As e escolha em seguida 
JPEG no menu Format.
2. Na janela de opções JPEG, escolha as opções 
que pretende e clique OK.
Image Options – Especifica a qualidade da imagem. 
Escolha uma opção do menu Quality, arraste o  
slider, ou especifique um valor entre 0 e 12 na caixa 
de texto Quality.

Vá verificando o preview da imagem para ver quando 
começa a perder muita qualidade.
 Format Options – Especifica o formato do 
seu ficheiro JPEG.
 Size – Faz aparecer o tempo estimado de 
download depois de seleccionada uma velocidade 
de modem. (o Size Preview só está disponível quan-
do o Prewiew está seleccionado).

Opções de formato para gravar ficheiros JPEG:
Baseline  (“Standard”) – utiliza o formato reconhe-
cido pela maior parte dos Web browsres.
Baseline Optimized – Cria um ficheiro com cores 
optimizadas e peso ligeiramente menor.
Progressive – Faz aparecer uma série de versões 
da imagem que vão aumentando de detalhe enquan-
to se procede ao download. Pode determinar quan-
tas imagens compõem série.

8.2 Comprimir imagens com o comando 
Save For Web:

Escolha File > Save For Web 
Seguidamente vai aparecer a janela do Image Ready 
onde podemos executar várias funções.

Imagem no Photoshop

quando o download está completo
Interlaced – faz aparecer no browser versões da im-
agem em baixa-qualidade enquanto é feito o down-
load da imagem. Esta forma interlaçada faz o tempo 
do download parecer mais curto, mas aumenta o 
peso do ficheiro.
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- Pré-Visualizar imagens
Encontra, no topo da janela, uma barra onde pode 
escolher uma das seguintes formas de pré-visualiza-
ção: 
Original (para ver a imagem sem qualquer optimi-
zação); 
Optimized (para ver a imagem com a optimização 
corrente); 
2-Up (para ver duas versões da imagem, lado a 
lado);
4-Up (para ver quatro versões da imagem lado a 
lado).

Pode experimentar várias opções de optimização e 
compará-las lado a lado. Se escolher trabalhar com 
a visualização 2-Up ou 4-Up deve fazê-lo antes de 
aplicar as opções de optimização. 

Um frame colorido indica qual a versão está selec-
cionada. 

- Navegar na janela de diálogo
Se a totalidade da imagem não é visível na janela 
Save For Web, pode utilizar a Ferramenta Mão 
(Hand Tool) para visualizar outras áreas. Seleccione 
a Hand Tool e arraste para a área de visualização 
para poder rolar sobre a imagem.

Pode também utilizar a ferramenta Zoom para au-
mentar ou reduzir a visualização.
Seleccione a ferramenta Zoom (lupa) e carregue na 
imagem para obter o efeito Zoom In.

Se pressionar a tecla ALT do teclado enquanto car-
rega na imagem, obtém o efeito inverso, Zoom Out. 
No canto inferior esquerdo da janela vai encontrar 
uma caixa onde poderá escolher ou escrever a per-
centagem de visualização que pretende.

- Ver informação de uma imagem optimizada
Na janela Save For Web existe uma área/barra em 
baixo da imagem que fornece informação acerca 
da optimização. A informação da imagem original 
consiste no nome e peso da imagem, a informação 
relativa à imagem optimizada mostra as opções de 
optimização correntes, o peso e o tempo de down-
load previsto baseado na velocidade do modem se-
leccionado. Pode escolher a velocidade do modem 
no Menu Preview.

Imagem no Photoshop
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Recapitulando: 
Para comprimir uma imagem: 
1. Escolha File > Save For Web  para abrir a janela 
de optimização (ImageReady).

2. Clique num dos separadores no topo da janela 
para seleccionar uma opção de visualização: Opti-
mized, 2Up ou 4Up. Se seleccionou a opção 4Up, 
clique depois na versão que deseja optimizar.

3. Seleccione um setting de optimização já definido 
no menu Preset (aconselhado para um nível in-
trodutório) ou defina as opções manualmente. 

4. Caso esteja a trabalhar com opções individuais 
de compressão, vá experimentado com as opções 
até estar satisfeito com a relação peso/qualidade da 
imagem.  

5. Quando estiver satisfeito, certifique-se que a 
versão que pretende guardar é a que está seleccio-
nada (linha azul em torno da imagem). Caso isso não 
aconteça, basta clicar uma vez em cima da versão 

que pretende gravar.

6. Seleccione Save e dê um nome ao seu ficheiro.

A imagem está agora comprimida e pronta a ser uti-
lizada numa página HTML ou num blog.

Veja Templates, Registar Área de Fotos para sa-
ber como inserir as suas imagens online.

Imagem no Photoshop

31/90



EDITAR

Vivemos uma revolução no mundo áudio. Os com-
putadores pessoais são autênticas estações de tra-
balho. Os músicos e produtores parecem crianças 
numa loja de doces.

Entretanto existe uma outra revolução a decorrer, 
chama-se Worldwide Web. As páginas Web já não 
estão limitadas a texto e imagens. A maior parte dos 
browsers consegue suportar uma variedade de for-
matos áudio (e vídeo) e, teoricamente, incluir um 
ficheiro áudio numa página não é mais complicado 
que incluir imagens. 

O áudio para a Web está a sofrer um grande cresci-
mento em certas áreas nomeadamente na Rádio via 
Internet e na distribuição de música online. Contu-
do, poucos sites incluem som. Porque é que a Web 
ainda é um mundo silencioso? A principal razão é a 
largura de banda.

Os ficheiros de som são pesados. Um CD Áudio 
standard (44.1 kHz, 16-bit stereo) pesa cerca de 10 
megabytes por minuto. Mesmo com uma ligação rá-
pida, esqueça... 

Som

Principais formatos áudio aceites na Web:

- MP3 (mp3): é o formato mais utilizado porque con-
segue excelentes compressões mantendo bastante 
qualidade sonora;

- Real Áudio(rm): é o mais popular dos formatos 
para streaming. É necessário um plug-in para o seu 
browser;

- Windows Wave (wav): É provavelmente o mais 
amplamente suportado dos formatos de som para 
Web pois é um formato nativo do Windows.
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O programa Audacity é um software gratuito que 
permite a edição de ficheiros de som de modo ex-
tremamente simples e eficaz. Nas páginas seguintes 
vai aprender a importar um som, fazer algumas             
operações de edição simples e preparar um ficheiro 
de som para integração na Net. 
Pode fazer o download do software aqui: 
http://audacity.sourceforge.net/ 

1. O Interface do Programa 

Ao abrir o Audacity, pode ver em cima um conjunto 
de botões e coisas para clicar. À primeira vista pare-
cem muitas, mas como vamos ver, só precisaremos 
de algumas.

Som no Audacity

- À esquerda, estão seis pequenos ícones – são as 
ferramentas. Falaremos das que precisamos mais 
à frente.
- Logo por baixo está o controle do volume do que 
ouvimos.
- À direita das ferramentas podemos encontrar o 
que vulgarmente se chama o “transporte” – são os 
botões que servem para pôr a tocar, parar, voltar ao 
início, ir para o final e gravar:

Triângulo verde – Play (tocar)
Quadrado amarelo – Stop (parar)
Duas barras azuis – Pause (pausa)
Setas cinzentas esquerda/direita – voltar ao início/
saltar para o fim
Círculo vermelho – Record (gravar) 

Por baixo do Transporte, regulamos o volume de 
entrada de som, quando queremos gravar alguma 
coisa.

Do lado direito, em cima, estão os indicadores de 
volume. 
O da esquerda é o que ouvimos, o da direita é o que 
gravamos. Estes indicadores dão muito jeito para 
perceber se está tudo ok com o som - às vezes pode 
estar muito alto e fica distorcido, ou estar muito baixo 
e ouvimos muito ruído.

Logo por baixo estão os atalhos – cada um deles 
realiza uma determinada função e poupa-nos o tra-
balho de procurar nos menus do programa, sempre 
que precisamos de executar alguma dessas fun-
ções.

2. Importar um som (formatos aceites)

A primeira coisa a fazer é importar a música para 
edição.
Para isso escolha File > Open
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Na caixa de diálogo que surge, devemos certificar-
nos que o menu “pull-down” chamado Enable: tem o 
formato do ficheiro que pretendemos abrir, ou, sim-
plesmente, a opção All files (*.*).
Ao encontrar o ficheiro certo, basta seleccioná-lo e 
clicar em Open. 

Depois de carregado o ficheiro, pode ver a represen-
tação gráfica da música em duas linhas, pelo facto 
de ser stereo. 
A linha de cima representa o canal esquerdo, en-
quanto que a de baixo, representa o direito. 
Sempre que edita um ficheiro stereo, os dois canais 
são sempre tratados como sendo um só e tudo o que 
faz em cima, é feito também em baixo.

3. Editar um ficheiro 

A primeira coisa é conseguir ouvir o som que impor-
tou.
Clique no botão Play no transporte (pode, em alter-

nativa, carregar na barra de espaço do teclado) e 
observar a linha que acompanha a reprodução da 
música. 
Clique em Stop (ou na barra de espaço novamente) 
para essa linha voltar ao ponto de partida.

3.1 As Ferramentas (Tools) Disponíveis

Para editar o seu ficheiro tem que utilizar as ferra-
mentas. Vamos agora perceber onde estão e o que 
fazem.

- Selection Tool

Esta é a ferramenta de selecção e navegação. Com 
ela selecciona as zonas “afectadas” quando executa 
comandos, funções, efeitos, etc.

É com esta ferramenta também que controla o ponto 
a partir do qual ouve a música - basta clicar com esta 
ferramenta num ponto qualquer da música, clicar em 
Play e a reprodução será iniciada a partir daí.

Som no Audacity
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Quando quer ouvir uma secção repetidamente (em 
loop), seleccione a secção pretendida, carregue na 
tecla Shift sem largar (o botão de play transforma-se 
num símbolo circular) e clique no Play – em alterna-
tiva pode usar o teclado: 
Shift + Barra de espaços.

Depois de seleccionar uma zona, pode fazer ajustes 
à selecção. Para isso basta usar o rato nas extremi-
dades da zona seleccionada (zona cinzenta escura) 
até o cursor mudar para uma mão com o dedo in-
dicador esticado.

Clique sem largar e, arrastando, reajuste os limites 
da selecção. Se for necessário reajustar com pre-
cisão (será certamente necessário), então é altura 
de usar outra ferramenta

- Zoom Tool

Esta á ferramenta que permite ampliar a imagem 
para ter uma melhor percepção do que vê ou maior 
precisão naquilo que faz.

Clicando na imagem da música com esta ferramen-
ta, amplia. Clicando enquanto carrega, sem largar, 
na tecla Shift, reduz.

 

Nos atalhos tem disponíveis estas duas funções, 
bem como outras duas, muito úteis: Visualizar toda a 
música, ou visualizar a zona seleccionada.

- Copy, Cut e Paste

Este programa permite-nos, também, utilizar as fun-
ções universais Copy, Cut e Paste (Copiar, Cortar 
e Colar). 

Estas acções, no Audacity, funcionam da forma tradi-
cional. A única diferença é elas que se aplicam a por-
ções específicas de áudio (e não texto ou caracteres, 
como normalmente acontece noutras 
circunstâncias).

Apenas é necessário ter em conta que, depois de 
copiarmos uma porção (Copy) – o material copiado 
permanece visível; se cortarmos (Cut) – o material 
cortado é removido. Para ambas as acções, podem-
os depois fazer Paste em qualquer ponto, desde que 
o indiquemos com a Selection Tool.

Som no Audacity
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Com a Selection Tool vai seleccionar uma zona que 
lhe pareça, auditivamente, um bom loop, isto é, um 
fragmento sonoro que tenha princípio e fim, ou que 
funcione bem isolada e repetidamente.

Experimente, de seguida, o loop, carregando em 
shift+barra de espaços.

3.2 Preparar um loop

Existem inúmeras técnicas para fazer um loop sem 
falhas aparentes, mas a melhor é o hábito, a ex-
periência. Até lá ficam algumas ideias:

Vamos usar o Zoom Tool para ampliar consideravel-
mente aquilo que vemos.
De seguida, com o Selection Tool, clique no início 
da zona que está a visualizar e faça Play.

Observe como certas partes da música, especial-
mente a batida, são tão fáceis de identificar – os pon-
tos mais altos e mais baixos correspondem 
literalmente a zonas que se ouvem mais ou menos, 
respectivamente.

Só com uma boa dose de sorte é que a primeira se-
lecção funcionará, de maneira que precisa agora de 
ajustar as fronteiras da zona seleccionada.

Para que o ajuste seja preciso, use a Zoom Tool em 
cada um dos limites da selecção. Em cada ajuste 
efectuado, confirme o resultado novamente com 
shift+barra de espaços. 

3.3 - Comprimir para a Internet

Depois de o Loop estar correctamente seleccionado 
(quando lhe soa bem), é altura de o transformar num 
ficheiro mp3. 
O mp3 é um formato áudio que, entre outras vanta-
gens, nos permite utilizar um loop sem que este seja 
muito pesado – ideal para a Internet.

Codec mp3

O Audacity necessita de um codec (abreviatura para 
enconder/decoder) que transforme o áudio original 
em formato mp3. 

Som no Audacity
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Esse codec pode ser descarregado da Internet 
gratuitamente em 
http://www.free-codecs.com/Lame_Encoder_
download.htm

Depois de instalado, basta abrir o menu Editar es-
colher preferências e em Configurações de Ex-
portação em mp3 carregar em Encontrar Plug-in 
e indicar a localização do ficheiro lame_enc.dll (o 
codec). A partir daqui o Audacity está preparado para 
converter áudio normal em formato mp3.

O processo agora é muito simples: Clique no menu 
File > Export Selection As MP3.

Na janela que abre, dê um nome ao ficheiro e es-
colha a localização no disco onde gravar. Clique em 
Save e o seu áudio está pronto a ser utilizado!
Seja para carregar no seu site apenas uma vez ou 
para ser tocado repetidamente em loop.

 

Agora que já temos os ficheiros de som num formato 
aceite na Web, basta inseri-los no site ou blog.

Veja Templates, Upload de Ficheiros e Publicar 
Vídeo/Áudio para saber como inserir os seus sons 
online.

Som no Audacity
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Som no SoundForge

O software SoundForge é um dos programas pro-
fissionais de edição de som disponíveis no merca-
do. Uma ferramenta poderosa com funcionalidades 
avançadas e sofisticadas. Neste e-book vamos 
abordar algumas funções básicas de edição de fi-
cheiros de som para a Internet. Uma introdução que 
lhe permita depois avançar ao seu ritmo.

1. O Interface do SoundForge 

Ao abrir o SoundForge, pode ver em cima duas filas 
de botões e ícones para clicar. No contexto deste 
e-book, só precisará de alguns, de maneira que fala-
remos apenas desses.

 

Na fila de cima, encontramos as mais variadas fun-
ções e operações. Os últimos quatro ícones são os 
mais importantes - as ferramentas. Falaremos das 
que precisamos mais à frente.

Na fila de baixo podemos encontrar o que vulgar-
mente se chama transporte – são os botões que 
servem para pôr a tocar, parar, voltar ao início, ir 
para o final e gravar:

Círculo – Gravar
Quadrado com setas circulares – Loop
Barra Triângulo – Step Play
Triângulo – Play
Duas barras – Pausa
Quadrado – Stop

Barra Seta para trás – Voltar ao início
Duas setas para trás/Duas setas para a frente 
– Rewind/Fast Forward
Seta para a frente Barra – Saltar para o fim.
Do lado direito, de alto a baixo, está o indicador de 
volume. Este indicador dá muito jeito para perceber 
se está tudo ok com o som - às vezes pode estar 
muito alto e fica distorcido, ou estar muito baixo e 
ouvimos muito ruído.

2. Importar um som

A primeira coisa que precisa de fazer é importar a 
música para começar depois a editar.

Escolha File > Open.

 

Na caixa de diálogo que surge, deve certificar-se que 
o “pull-down” menu chamado Files of type: tem o 
formato do ficheiro que pretende abrir, ou, simples-
mente, a opção All Known Media Files.
Ao encontrar o ficheiro certo, basta seleccioná-lo e 
clicar em Open. 

 

38/90



EDITAR

Pode ver a representação gráfica da música em duas 
linhas, pelo facto de ser stereo. A linha de cima rep-
resenta o canal esquerdo, enquanto que a de baixo, 
representa o direito. Sempre que edita um ficheiro 
stereo no SoundForge, os dois canais podem ser 
tratados como um só ou ser editados em separado.

Vamos agora clicar no botão Play no transporte 
(podemos, em alternativa, carregar na barra de es-
paço do teclado) e observar a linha que acompanha 
a reprodução da música. Ao clicar em Stop (ou na 
barra de espaço novamente) essa linha volta ao pon-
to de partida.

3. Editar um ficheiro 

Agora que o ficheiro de som já está carregado no 
programa, pode começar a seleccionar fragmentos 
de som.

3.1 As Ferramentas (Tools)

- Selection Tool 

Esta é a ferramenta de selecção e navegação. Com 
ela selecciona as zonas “afectadas” quando executa 
comandos, funções, efeitos, etc.

É com esta ferramenta também que controla o ponto 
a partir do qual ouve a música - basta clicar com esta 
ferramenta num ponto qualquer da música, clicar em 
Play e a reprodução será iniciada a partir daí.

Quando quer ouvir uma secção repetidamente (em 
loop), seleccione a secção pretendida, active o modo 
Loop e clique no Play. 

Som no SoundForge
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Depois de seleccionar uma zona, pode fazer ajustes 
à selecção. Para isso basta usar o rato nas extremi-
dades da zona seleccionada (zona preta contrasta-
da) até o cursor mudar para uma seta horizontal com 
duas pontas.

Clicamos sem largar e, arrastando, reajustamos os 
limites da selecção. Se for necessário reajustar com 
precisão (será certamente necessário), então é al-
tura de usar outra ferramenta.

- Zoom Tool

Esta é a ferramenta que lhe permite ampliar a ima-
gem para ter uma melhor percepção do que vê ou 
maior precisão naquilo que faz.

Com esta ferramenta basta “desenhar” a área do 
áudio que pretende ampliar e quando larga o botão 
do rato, essa área ocupará a totalidade da janela, 
dando-lhe uma perspectiva mais precisa da área.

Em baixo do lado direito, pode encontrar dois ícones 
que lhe permitem facilmente ampliar e reduzir em 
quantidades pré-definidas – outra forma prática de 
ampliar e reduzir.

 

- Copy, Cut e Paste 

Este programa permite-nos, também, utilizar as fun-
ções universais Copy, Cut e Paste (Copiar, Colar e 
Cortar). 

Estas acções, no SoundForge funcionam da forma 
tradicional. A única diferença é elas que se aplicam a 
porções específicas de áudio (e não texto ou 
caracteres, como normalmente acontece noutras cir-
cunstâncias).

Apenas é necessário ter em conta que, depois de 
copiarmos uma porção (Copy) – o material copiado 
permanece visível; se cortarmos (Cut) – o material 

Som no SoundForge
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cortado é removido. Para ambas as acções, pode-
mos depois fazer Paste em qualquer ponto, desde 
que o indiquemos com a Selection Tool.

3.2 Preparar um loop

Existem inúmeras técnicas para fazer um loop sem 
falhas aparentes, mas a melhor é o hábito, a ex-
periência. Até lá ficam algumas ideias:

Utilize a Zoom Tool para ampliar consideravelmente 
aquilo que vê.
De seguida, com a Selection Tool, clique no início 
da zona que está a visualizar e faça Play.

Observe como certas partes da música, espe-
cialmente a batida, são tão fáceis de identificar 
– os pontos mais altos e mais baixos correspondem                 
literalmente a zonas que se ouvem mais ou menos, 
respectivamente.

Com a Selection Tool seleccione uma zona que lhe 
pareça, auditivamente, um bom loop – um fragmento 
sonoro que tenha princípio e fim, ou que funcione 
bem isolada e repetidamente.

Experimente, de seguida, certificando-se que o 
modo de Loop está activado, fazendo play (barra de 
espaço).

Só com uma boa dose de sorte é que a primeira se-
lecção funcionará, de maneira que precisa agora de 
ajustar as fronteiras da zona seleccionada.
Para que o ajuste seja preciso, use a Zoom Tool em 
cada um dos limites da selecção. O SoundForge é 
um editor bastante avançado, de maneira que o loop 
que ouvimos é automaticamente actualizado a cada 
ajuste efectuado. Basta-lhe fazer os ajustes e estar 
atento.

3.3 Comprimir para a Internet 

Depois do Loop estar correctamente seleccionado 
(quando lhe soa certo), é altura de o transformar 
num ficheiro mp3. O mp3 é um formato áudio que, 
entre outras vantagens, nos permite utilizar um loop 
sem que este ocupe muito espaço – ideal para a              
internet.

Antes da criação do ficheiro mp3, vamos “limpar” o 
áudio que não nos interessa, ou seja, tudo aquilo 
que está antes e depois do loop.
Para isso, basta executar o comando Trim/Crop que 
se encontra no menu Edit.
Como pode ver, ficou apenas com o loop.

Som no SoundForge
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O processo agora é muito simples: Clique no menu 
File > Save As

 

Na janela que abre, escolha a localização no disco 
onde gravar e, em baixo, dê o nome ao loop no cam-
po File Name. 
No campo seguinte Save as Type, escolha “MP3 Au-
dio (*.mp3)”. 
No campo Template, escolha 128Kbps, CD Quality 
Audio.
Por fim, clique em Save e o seu áudio está pronto a 
ser usado.

Se não pretender fazer loop a partir de um fragmento 
sonoro, basta seguir as mesmas etapas: seleccionar 
o fragmento, fazer Trim/Crop e depois fazer Save 
As da forma acima explicada. 

Agora que já temos os nossos ficheiros de som num 
formato aceite na Web, basta inseri-los no site ou 
blog. 

Veja Templates, Upload de Ficheiros e Publicar 
Vídeo/Áudio para saber como inserir os seus sons 
online.

Som no SoundForge
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Gravar um Som

No Audacity

Tudo aquilo que já vimos até agora no Audacity não 
se aplica apenas a sons ou música que já temos – 
um mp3, ou uma gravação que nos passaram.

Podemos aplicar o mesmo procedimento a qualquer 
som que quisermos. Para isso, basta fazê-lo chegar 
ao nosso computador através da placa de som.

Pode usar um microfone, ligar um leitor de mp3, um 
instrumento eléctrico, etc.
Ligue a sua fonte sonora à entrada da placa de som 
e, antes de gravar, a primeira coisa que precisa de 
fazer é certificar-se que o volume da fonte sonora é 
adequado: nem muito elevado, nem demasiado re-
duzido. 
Para isso, clique no pull down menu acessível no in-
dicador de volume de entrada, ao lado do pequeno 
ícone do microfone, e escolha a opção Monitor In-
put.

Ao observar o indicador, o máximo de volume 
não deverá chegar ao zero nem ser inferior a -12.                
Estes valores são de referência e devem garantir 
uma qualidade de gravação aceitável, se o equipa-
mento assim o permitir.

 

Depois de confirmado o volume de entrada e tudo 
lhe parecer estar preparado, pode então gravar.
Para gravar:
- Clique no círculo vermelho do Transporte e faça o 
mesmo que fez durante o teste de som, mas desta 
vez, tudo ficará registado.

 

Quando não quiser gravar mais, clique no Stop.

 

Este novo som gravado pode ser editado da mes-
ma forma que editou a música anterior. (veja Editar 
Som no audacity)

Não vamos cobrir a gravação de som no Sound-
Forge dado que as definições de gravação para este 
programa são bastantes avançadas e neste contexto 
não vale a pena complicar.

De seguida, experimente a sua fonte sonora: fale 
para o microfone ou coloque o leitor de mp3 a tocar, 
conforme a situação.
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Podcast

A palavra está na moda, mas afinal de contas, o que 
é um podcast?

Podcasting é um método de distribuição de ficheiros 
multimédia (como, por exemplo, um ficheiro áudio), 
através da Internet, e usando uma espécie de aler-
tas (syndication fees), para que esses ficheiros pos-
sam depois ser vistos/ouvidos em leitores de mp3, 
computadores, etc. O nome nasceu em 2004, e mis-
tura “iPod”, um popular leitor de MP3, vídeos e fo-
tos, e o termo “broadcasting” a palavra inglesa para 
“emissão”. 

Um podcast implica alguma periodicidade de              
actualização de conteúdos. Essa periodicidade varia 
consoante o autor (ou autores) do podcast. É como 
nos blogs, há quem tenha novos conteúdos todos os 
dias, há quem tenha novos conteúdos uma vez por 
semana ou mesmo uma vez por mês. Há também 
quem tenha podcasts de actualização muito variá-
vel.

Um podcast é habitualmente temático, seja porque 
foca um determinado assunto, seja porque o seu 
autor é uma pessoa conhecida. Há muitos podcasts 
que são excertos de programas de rádio, embora 
a grande maioria seja feita propositadamente para 
podcast.

Se quisermos subscrever um podcast, isto é, pas-
sar a receber no nosso leitor de mp3 os novos 
“episódios” de um determinado podcast, deveremos                        
“subscrevê-lo”, isto é, deveremos informar o nosso 
programa de gestão de ficheiros que pretendemos 
ter no nosso leitor de mp3 os conteúdos daquele pod-
cast. Da mesma forma podemos anular subscrição e 
deixar de receber os episódios.

Alguns dos programas que “agregam” este tipo de fi-
cheiros podem ser encontrados online e são, maiori-
tariamente, gratuitos.

Sempre que abrirmos esse agregador, este vai à pro-
cura em todos os podcasts subscritos, verificando se 
há actualizações. Caso haja novos “episódios”, é de 
imediato feito o download para o nosso leitor de mp3 
(caso este esteja ligado ao PC, obviamente).

Podemos depois ouvir o podcast quando quisermos, 
tal como ouvimos uma música, ou vemos um vídeo.

Para procurar podcasts cujos conteúdos nos pos-
sam interessar, há vários Directórios (e todos os dias 
nascem mais, são como os cogumelos), aqui ficam 
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alguns dos mais conhecidos:

Esta é a parte de quem consome podcasts.

E quem quer ser um podcaster (nome do autor de 
um podcast), como é que faz?

Bom, precisa de algum equipamento, de áudio, caso 
se trate um podcast de áudio. Nada de complicado, 
por exemplo, um gravador de som, digital, daqueles 
que usamos em casa, chega e sobra.

A parte mais difícil são os conteúdos, conteúdos de 
qualidade não se “arranjam” ao virar da esquina, têm 
de ser pensados, e dão trabalho. A grande vantagem 
dos podcasts é que não são em directo, podem ser 
ensaiados vezes sem conta, até que estejamos 
satisfeitos com o resultado final.

Depois do ficheiro pronto, há que “transformá-lo” em 
podcast, isto é, dar-lhe a capacidade de comunicar 
com os agregadores, para os avisar de que 
existem novas actualizações.

Para proceder a essa transformação, de simples fi-
cheiro de som em podcast, é necessária uma aplica-
ção específica. Podem encontrar-se várias, mas são 
habitualmente pagas.

Muitas vezes os podcasts estão associados a blogs, 
onde os “ouvintes” podem comentar um determinado 
podcast. Use e abuse do seu blog.

Depois de pronto o ficheiro, basta enviá-lo para um 
servidor (o das Homepages do SAPO serve linda-
mente, e, depois disso, anunciar ao mundo a existên-
cia de mais um podcast. Use o seu blog, use o blog 
oficial do Podcasting do SAPO (http://podcasting.
blogs.sapo.pt) e agora que o episódio piloto já está 
“no ar”, comece de imediato a trabalhar no próximo.

Podcast

Nacionais:
Podcasting.blogs.sapo.pt 
http://podcasting.blogs.sapo.pt/

Lusocast
http://www.lusocast.com/

Internacionais:
Odeo 
http://www.odeo.com/

Podcast.net 
http://www.podcast.net/

podcastpickle.com 
http://www.podcastpickle.com/

Yahoo! Podcasts
http://podcasts.yahoo.com/

Podcasting News
http://www.podcastingnews.com/

Podfeed.net
http://www.podfeed.net/

Podcast Alley
http://www.podcastalley.com/

PodNova
http://www.podnova.com/

PodTrac
http://www.podtrac.com/
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A compressão de vídeo tem sofrido grandes desen-
volvimentos nos últimos anos. Os formatos agora 
disponíveis são muito mais leves que os do passado 
conseguindo manter uma qualidade razoável. Ainda 
assim, não existe aquilo a que podemos chamar um 
ficheiro de vídeo pequeno, todos eles requerem uma 
largura de banda significativa. Quando um típico 
filme em DVD pesa um Gigabyte é fácil perceber 
que mesmo um vídeo pequeno vai demorar bastante 
tempo a ser carregado, mesmo com uma rápida liga-
ção à Internet. 

Há muito a dizer acerca da presença de programas 
de televisão, filmes e vídeos na Internet, mas o facto 
é que a tecnologia ainda não está pronta para tal. 
Assim, o melhor que podemos esperar nesta altura 
são vídeos com pequenas áreas (esqueça o ecrã to-
tal) e de curta duração (sim estamos mesmo a falar 
de minutos ou até segundos!).

Principais formatos aceites na Web:

Windows Movie Vídeo (WMV): atinge uma boa 
compressão e tem a vantagem de poder ser visto em 
todos os computadores com sistema Windows sem 
ser necessário fazer o donwload de um programa 
para o ler.

Real: bastante potente, consegue boas compressões 
e é o mais adequado para fazer streaming online 
(streaming quer dizer que as pessoas não têm que 
esperar que a totalidade do ficheiro carregue para o 
poderem começar a ver). 

Quicktime: consegue a melhor qualidade mas nor-
malmente cria ficheiros de maior dimensão.
Informação sobre compressão vídeo é bastante 
complexa e está em constante evolução. Neste 
e-book, optámos por utilizar o formato do Windows 
por questões de simplicidade e também porque a 
maioria das pessoas consegue ler este tipo de fichei-
ros.

Vídeo
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Actualmente quase toda a gente tem um computador, 
e muitos uma câmara de filmar ou uma webcam, o 
que significa que todos somos potenciais  realiza-
dores e editores dos nossos filmes. Parafacilitar esta 
tarefa, a Microsoft incorpora no Windows XP uma 
ferramenta para edição de vídeo extremamente fácil 
de utilizar: o Windows Movie Maker (WMM).

A transferência de vídeos para o PC não podia ser 
mais simples: basta ligar a câmara ao PC utilizando 
um cabo FireWire (IEEE 1394 ) ou um Cabo USB, 
abrir o programa de edição e ligar a câmara no modo 
de reprodução (player). 
O software reconhece e configura a câmara auto-
maticamente, seja webcam ou câmara de filmar.

1. Capturar Vídeos

A primeira coisa que precisa de fazer é “carregar” o 
vídeo no seu computador. 

1.1 Clique em Start > Programs > Windows Movie 
Maker
para abrir o Interface Movie Maker.

1.2 Seguidamente tem que dizer ao programa que 
quer capturar vídeo: escolha o menu File > Capture 
Video.

Depois escolha o dispositivo: webcam ou câmara de 
filmar.

1.3 Após ter escolhido o dispositivo clique Next para 
dar um nome e definir a localização do vídeo que vai 
capturar.

Vídeo no Movie Maker
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1.4 Pode ajustar alguns parâmetros do vídeo, como 
o formato e a compressão. 

Dado que o WMM tem algumas definições por defei-
to, basta escolher o formato que melhor se enquadra 
à sua situação. Como estamos a pensar na Net 
vamos escolher vídeo para a Web.

1.5 Segue-se o processo de captura, ou seja, a 
transferência do vídeo para o computador que pode 
ser feita de duas maneiras:

1- Transferir todo o conteúdo da cassete, no caso 
de uma câmara de filmar, ou deixar a gravar se for 
uma webcam, até não precisar mais.
2- Escolher as partes do vídeo que quer editar.

Para gravar o vídeo para o computador, clique no 
botão Start Capture no WMM no local da cassete a 
partir do qual quer capturar. A câmara arranca 

automaticamente a reprodução.

Clique no botão Stop Capture e a câmara pára au-
tomaticamente. 

Podem ser capturadas várias partes, bastando 
para isso ir navegando na cassete e fazendo ciclos 
de Start Capture e Stop Capture. Quando já tiver    
capturado todas as partes pretendidas clique no 
botão Finish. 

O WMM separa automaticamente os vários frag-
mentos e apresenta-os no programa para posterior       
edição.

Vídeo no Movie Maker
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2. Editar os Vídeos Capturados

Agora que já tem os vídeos no computador ainda em 
estado bruto é tempo de começar a editar e a pre-
parar o vídeo para a gravação final. 

Este processo tem três etapas:
- a edição do vídeo, isto é, a escolha e montagem 
das cenas com mais interesse; 
- os tratamentos que serão necessários aplicar ao 
vídeo para corrigir imperfeições ou acrescentar efei-
tos; 
- a codificação final, tendo em conta o fim a que se 
destina o vídeo.

2.1 O Interface do Programa

No ecrã do WMM existem três espaços distintos:

- à esquerda estão as funcionalidades do pro-
grama;
- ao centro a livraria, onde são mostrados todos 
os clips capturados e material importado quer sejam 
vídeos, fotos ou músicas (ver parágrafo seguinte); 
- à direita está o monitor, que serve para visualizar 
os vídeos e o trabalho final à medida que este vai 
avançando.

2.2 Importar Ficheiros

Para importar ficheiros basta ir à janela mais à es-
querda e clicar na opção Import pretendida. Para 
visualizar os clips ou ouvir as músicas que estão na 
livraria basta clicar duas vezes no ficheiro pretendido 
ou arrastá-lo para cima do monitor do lado direito do 
ecran.

Vídeo no Movie Maker
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2.3 O Storyboard e a Timeline

Com o WMM podemos ter uma visão de Storyboard, 
que serve apenas para alinhar os clips que preten-
demos pela ordem que queremos que apareçam, e 
uma visão Timeline, onde vão ser montados e trata-
dos os clips.

Comece por escolher os clips e a ordem em que pre-
tende que apareçam. Clique no clip e arraste-o para 
o Storyboard.

Pode facilmente, e em qualquer altura, mudar a or-
dem dos clips ou a sequência: basta arrastar os clips 
para as posições pretendidas. 

Depois de ter os clips alinhados no Storyboard clique 
Play no monitor para visualizar a sequência.

Vídeo no Movie Maker
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2.4 Montagem

Seguidamente, e depois de estar tudo alinhado no 
Storyboard, clique em Show Timeline para iniciar o 
processo de montagem.

Com o modo Timeline aberto podemos facilmente 
cortar, aparar, colocar transições e efeitos.

2.5 Transições e Efeitos

Para colocar transições e efeitos clique em View 
Vídeo Effects ou View Vídeo Transitions, na barra 
Edit Movie.

Vídeo no Movie Maker
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Estes são os Efeitos que podemos arrastar para as 
partes de vídeo que desejamos:

Transições entre os vídeos, que podemos arrastar 
para o início de cada parte do vídeo:

3. Codificação Final

O passo seguinte é a Codificação Final, em que vai 
ser processada toda a montagem que esteve a fazer, 
de modo a compactar todos os clips que utilizou na 
Timeline, todos os cortes, efeitos, transições.

Todos estes elementos se tornam um só ficheiro que 
pode ser .AVI, .MPEG, .MOV, .WMV, .DIVX,  etc, 
consoante o fim a que se destina o vídeo.

- Clique em Finish Movie, no lado esquerdo do ecrã, 
e seleccione qual a utilização que vai dar ao filme: 
pode ser enviado para a Web, enviado por Email, 
transferido para uma cassete de câmara de filmar ou 
para um CD, ou pode simplesmente ser guardado no 
computador.

Vídeo no Movie Maker
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- Sempre que seleccionamos uma das formas de 
codificação que são apresentadas (ex: Send to 
Web) temos que dar um nome ao trabalho.

-  Para finalizar, vamos definir a qualidade do filme 
escolhendo uma das hipóteses: Modem Analógi-
co 56K ou ADSL 384K. Tem de ter em atenção o 
seguinte, se escolher uma qualidade para ADSL, 
que é a mais elevada, o utilizador que tiver um 
Modem Analógico 56K, que é muito lento, poderá ter 
dificuldades em conseguir ver o trabalho. 

Veja Templates, Upload de Ficheiros e Publicar 
Vídeo/Áudio para saber como inserir os seus vídeos 
online.

Vídeo no Movie Maker
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Edição de vídeo no Premiere

O software Premiere, da Adobe, é um dos padrões 
de edição vídeo profissional. Uma ferramenta robus-
ta e sofisticada. Neste e-book, vamos ensiná-lo a 
editar e preparar os seus vídeos para a Web.

1. Iniciar um Projecto

O primeiro passo é carregar o vídeo para o computa-
dor. Pode fazer isto através do programa.
 
-  Clique em Start > Programs > Adobe Premiere 
Pro 
Pode criar um novo projecto ou abrir algum que já se 
encontre feito. Neste ecrã apenas cria um projecto 
onde vai colocar os seus vídeos para futura edição.

- Dê um nome ao seu projecto e escolha uma pasta 
no computador onde deseja guardar o trabalho. De-
pois escolha as definições do projecto, que deverão 
sempre ser DV-Pal Standard 48K pois o nosso siste-
ma de televisão de origem apenas funciona no modo 
PAL 25 FPS e não NTSC 30 FPS.

2. O Interface do Programa

O interface do Adobe Premiere divide-se em quatro 
áreas:

1- A Livraria, onde aparecem todos os clips que cap-
turámos mais os que importarmos: mais vídeos, fo-
tos ou músicas.

2- Neste monitor, que podemos chamar de                    
Pré-edição pode ver os vídeos, músicas ou fotos 
que existem na livraria, ao contrário do Movie Maker 
onde apenas se pode visionar um único vídeo num 
monitor. 

3- Este é o Monitor final. Neste monitor visualiza não 
só o trabalho de edição que se faz em baixo (na 

Vídeo no Premiere
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Timeline) mas visualiza também o resultado final.

4- Esta é a Timeline. Nesta área faz os cortes das 
partes que não gosta, coloca músicas a acompanhar 
os vídeos, fotos, etc. É a sua área de trabalho.

  

3. Capturar um Vídeo
 
Vamos então começar a Capturar um vídeo da Câ-
mara de vídeo.       

- Escolha File > Capture 

A captura pode ser feita de duas formas:
1- transferindo todo o conteúdo da cassete;
2- escolhendo as partes do vídeo que quer utilizar.

- Clique no botão Rec no Adobe Premiere no ponto 
da cassete a partir do qual quer capturar. A câmara 
arranca automaticamente a reprodução.
- Clique no botão Stop: a câmara pára 

automaticamente. 

Podem ser capturados vários trechos, bastando para 
isso ir navegando na cassete e fazendo ciclos de 
Rec e Stop.

- Quando já tiver capturado todas as partes preten-
didas basta fechar a janela no X no canto Superior 
Direito. 

O programa separa automaticamente os vários 
fragmentos e apresenta-os na Livraria para serem 
editados.

Como pode ver, na Livraria já tem o clip e pode vi-
sioná-lo no monitor ao lado fazendo Play.

Vídeo no Premiere
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4. Edição

Agora que já transferimos para o computador o ma-
terial pretendido, vamos à melhor parte: editar!

Para começar, arraste o seu vídeo para a Timeline. 
Esta Timeline tem por defeito várias pistas de vídeo 
e áudio. Se o seu vídeo tiver áudio, vai poder visioná-
lo na pista de áudio.

Para editar o vídeo vai usar as ferramentas que se 
encontram na barra de ferramentas do lado esquer-
do da Timeline.

4.1 Importar Ficheiros

Se pretender adicionar Fotos ou mais Vídeos ou até 
Músicas, seleccione File > Import . Os ficheiros que 
escolher são importados e ficam na Livraria junto de 
todos os outros elementos do projecto.

Vídeo no Premiere
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4.2 Efeitos

Para colocar efeitos e transições:
- clique no menu Livraria Efects, arraste o efeito pre-
tendido para a Timeline (pode colocá-lo em qualquer 
local da Timeline). Neste exemplo foi usado o efeito 
Invert, mas pode descobrir muitos mais!

- Sempre que aplica um efeito ao clip, o programa 
assinala-o na Timeline com uma linha verde. 

5. Exportar Vídeos 

Agora que o vídeo já está pronto, falta apenas ex-
portá-lo para um formato adequado.

- Seleccione File >Export 
Existem várias formas de exportar o trabalho. Podem-
os fazer uma cópia para ficar no nosso computador, 
exportar para a cassete da Câmara e Exportar para 
a Web.

- Exportar para a Web
Seleccione File > Export > Adobe Media Encoder
Aqui pode escolher qual o formato que pretende: 
Windows Media, Real Media ou QuickTime      
Movie, uma vez que estes são os principais forma-
tos aceites na Web. 

Para perceber as diferenças entre estes formatos, 
faça testes com um mesmo clip. Na realidade, tra-
tam-se apenas de diferentes softwares de leitura 
vídeo com algumas diferenças mas no fundamental 
fazem a mesma coisa.

Vídeo no Premiere
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- Depois de escolher o formato que pretende, é ne-
cessário definir a Qualidade.

- Seleccione Preset, aqui tem várias escolhas desde     
até muito boa qualidade consoante o tipo de velo-
cidade da Internet.

O vídeo é sempre bastante mais pesado do que a 
imagem, o que significa que as pessoas terão que 
esperar sempre algum tempo para ver o seu vídeo. 
Faça vários testes para encontrar a relação ideal en-
tre peso/qualidade do vídeo.

Vários softwares livres 
http://www.emcena.com/artigo.asp?id_artigo=4296

Software Pago 
Onde pode fazer download de uma versão de 30 
dias teste.
http://www.adobe.com/pt/
http://www.adobe.com/br/products/premiere/
 

Alguns manuais livres
http://www.kidzonline.org/TechTraining/video.
asp?UnitQry=Digital%20Video

Calculadora de tempos de download
http://www.martindalecenter.com/AATimeCalc.html

Veja Templates, Upload de Ficheiros e Publicar 
Vídeo/Áudio para saber como inserir os seus vídeos 
online.

Vídeo no Premiere
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Registar um blog, uma homepage e um 
álbum de fotos, no SAPO. 

Ok. Já tem a ideia, já tem a estrutura, já tem os con-
teúdos (textos, imagens, fotos, vídeos, etc.). E ago-
ra?

Agora é publicar.

Se para procurar usámos a Internet e fomos recep-
tores de informação, chegou agora a nossa vez de 
retribuir, e de passarmos a ser emissores de infor-
mação.

Antes de mais, vamos decidir qual é o tipo de serviço 
que melhor se adapta aos seus objectivos.

Pretende colocar online um trabalho (seja sobre o 
que for), em que as actualizações não são frequen-
tes (vá... uma vez por semana). São textos, fo-
tos, vídeos, e são mais ou menos estáticos. Então          
escolhemos uma homepage.

Se o seu trabalho ou projecto é dinâmico, tem muitas 
actualizações (pelo menos uma por dia), e pretende 
ser um espaço com uma comunicação evolutiva e 
frequente, que permita de forma alargada a partici-
pação dos visitantes, é um blog.

Se apenas pretende colocar online as suas fotos, ou 
as fotos dos seus amigos (atenção às questões de 
segurança e privacidade (Capítulo Segurança), ou 
as fotos da sua família, para que possa partilhá-las 
com os seus amigos, colegas e familiares, então é 
uma área de fotos.

Mas... e se quiser um pouco de tudo? Um espaço 
dinâmico, que tem uma área mais estática, uma área 
mais versátil, muitas fotos, muitos vídeos... o que é 
que podemos usar?

Simples. Tudo
Os serviços do SAPO são grátis, e qualquer pessoa 
os pode utilizar.
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Vamos começar pelo princípio (como na história). 
Para poder usar os serviços do SAPO tem de ter um 
login e uma password. Não é novidade, é assim em 
todo o lado, e ainda bem, porque é este conjunto de 
dados (login e password) que garantem que apenas 
nós e mais ninguém acede aos serviços que regis-
támos.

No SAPO (tal como noutros portais) o login é um 
endereço de e-mail.

Mais à frente explicamos mais profundamente as 
questões do e-mail, agora vamos apenas explicar como 
é que se regista um endereço de e-mail, no SAPO.

Já tem um endereço de e-mail no SAPO? Vá para o 
passo seguinte.
 
Se ainda não tem um endereço de e-mail do SAPO, 
dirija-se à página inicial do SAPO Mail em http://mail.
sapo.pt

Clique em “Criar Conta”. É um botão enorme, mas 
pelo sim pelo não, colocámos ali uma seta cor de 
laranja, para não escapar.

Agora, muita atenção. Vai ser preciso escolher um 
endereço de mail. Este endereço não é só o seu log-
in nos serviços SAPO, é também o seu endereço de 
mail, por isso, tem de ser a sua cara. Não pode ser 
nada difícil de fixar portanto o endereço 0liv31r1nh4t
h4m4n1sth3b3st@sapo.pt  ficará de fora das nossas 
opções.

Qualquer coisa simples, mas que identifique o dono 
do mail.

Escolha também uma password. Aqui as regras são 
as opostas das anteriores. Escolha algo que não seja 
óbvio. Nem datas de nascimento, nem o nome da “tal 
pessoa” nem o seu próprio nome. Algo complicado 
para os outros mas simples para si de se recordar, 
e neste caso, é na infidelidade que está o segredo 
do sucesso (SÓ neste caso), mude de password 
com frequência e NUNCA  diga a ninguém, nem ao 
melhor amigo, nem ao irmão, nem ao tio nem à tia. 
Neste caso, ninguém, é mesmo ninguém.

Portanto, escolheu o endereço, identificou uma pass-
word. Confirme a password que escolheu. Da lista 
de perguntas de recuperação de password, escolha 
a que quiser, e dê a resposta. Isto serve para que a 
possa recuperar mais tarde, caso se esqueça dela.

Criar um E-mail no Sapo
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Preencha os restantes dados que lhe são pedidos e 
já está. Já tem um endereço de mail e uma password 
que são os elementos fundamentais para poder regi-
star-se em qualquer outro serviço do SAPO. Mais à 
frente vamos falar mais do mail, e de como utilizá-lo, 
mas para já, não precisamos de mais nada do mail.

Criar um E-mail no Sapo
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Criar um Blog no Sapo

Nos dias que correm, toda a gente tem opinião. Con-
sequentemente, toda a gente com opinião, e que 
queira partilhá-la, tem um blog. 

Ter um blog não só está na moda, como é útil. 
Podemos partilhar o que pensamos, o que sentimos, 
o que queremos, o que achamos que está bem e o 
que achamos que está mal. 

Com um blog, tudo isto deixa de estar limitado à es-
fera de pessoas que nos rodeiam, e passa a estar 
disponível para o mundo. É como partilhar o que 
pensamos com o mundo inteiro, e de certeza que 
no mundo inteiro, há-de haver quem pense o mes-
mo que nós, e há-de haver quem não concorde. E 
criam-se debates, trocas, discussões (umas mais 
saudáveis que outras), e ficamos todos a ganhar.

Mas afinal de contas, o que é um blog?

A definição de blog não é consensual. Um blog é um 
registo cronológico e frequentemente actualizado 
de opiniões, emoções, factos, imagens ou qualquer 
outro tipo de conteúdo que o autor ou autores quei-
ram disponibilizar

Um blog pode servir vários objectivos. É sempre uma 
forma do seu autor ou dos seus autores se expres-
sarem, de publicarem o que querem ver publicado, e 
que provavelmente não se enquadraria em qualquer 
outro meio de comunicação. Pode servir para ter um 
diário pessoal online, pode servir como ferramenta 
de comunicação entre pessoas com interesses co-
muns, pode servir para registar o desenvolvimento 
de um determinado processo (uma gravidez ou uma 
dieta, por exemplo), pode servir para fazer ouvir uma 

voz (ou várias vozes) que não teriam a possibilidade 
de se expressarem em qualquer outro meio.

Porque é que há tantos blogs? Porque é que toda a 
gente tem um blog?

Porque são fáceis de criar e de gerir. Esta é a grande 
vantagem dos Blogs do SAPO. Não necessitam 
de grandes conhecimentos técnicos sobre html,              
javascript, flash, ou outras coisas complicadas que 
não precisam de ser referidas.

E de facto é simples. Já tem o seu endereço de mail, 
certo? Então vá até à página inicial dos Blogs em 
http://blogs.sapo.pt

Clique no botão do costume “Crie o seu Blog”.

Mais uma vez, atenção, vai registar o endereço com 
que vai ficar (e que não pode ser alterado mais tar-
de), escolha algo simples, que dê de imediato uma 
ideia da temática principal do seu blog, ou da sua 
pessoa.

Preencha os dados que lhe são pedidos, o seu 
endereço de mail e respectiva password, o endereço 
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(ou url, que é a mesma coisa), active a caixa em que 
refere ter lido os termos de utilização (e leia-os, já 
agora), preencha os números e as letras que lhe 
aparecem na imagem (daqui a bocadinho já expli-
camos para que é que isto serve, mas é uma forma 
de nos protegermos contra o spam) e clique em Ok.

Pronto, o seu Blog foi criado com sucesso. Agora es-
colha, pode começar de imediato a publicar os seus 
posts (posts ou artigos, 
é tudo a mesma coisa), ou pode em primeiro lugar 
escolher o visual que quer que o seu blog tenha. 
Personalizar o blog é dar-lhe o toque pessoal que o 
identifica de imediato como sendo seu. Seja com fo-
tos, com imagens, com cores... é fácil, e vamos falar 
sobre isso de imediato.

O seu blog, neste momento, tem este aspecto:

Pronto, ainda não é grande coisa. Não tem título, 
não tem conteúdos. Mas agora entramos em campo 
com a oferta de templates (designs diferentes) do 
SAPO e com a sua imaginação e criatividade (os 
conhecimentos técnicos não são para aqui chama-
dos, porque não são necessários).

Vamos à área de personalização do blog.

Na personalização básica temos uma montra. É 
como ir às compras, mas sem pagar nada. Vamos 
escolher o template (design) base que melhor se 
adapta às nossas necessidades e gostos. Há tem-
plates para todos os gostos.

Criar um Blog no Sapo
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Escolha o que mais lhe agradar, mas pode, a qualquer 
momento, mudar de opinião, voltar a olhar para a 
montra, e escolher outro template, sem perder quais-
quer posts (artigos) que tenha entretanto publicado.

Certo, já escolhemos um template.

Vamos agora adicionar um título ao blog, e a nossa 
foto (ou uma imagem que se relacione connosco).

Como insiro a foto de perfil?

Basta que vá até à sua área de perfil, clicando no 
botão “Perfil” disponível na barra de navegação su-
perior, e depois de aceder a essa área, clicar na op-
ção “Foto do Perfil”. 

Criar um Blog no Sapo
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Pode optar por mostrar a sua imagem a partir de um 
endereço onde o ficheiro já esteja alojado, ou por 
enviar o ficheiro para os Blogs.

Se optar por mostrar uma foto a partir de um endereço, 
active o “radio button” que selecciona essa opção, e 
insira o endereço da imagem que pretende mostrar, 
no campo de escrita disponível para o efeito.

Se optar por enviar o ficheiro da imagem para os 
Blogs, active o “radio button” que selecciona essa 
opção. Clique de seguida no botão “Browse/Procu-
rar” e indique a localização do ficheiro no seu com-
putador. No final, clique em “Ok”. 

Para guardar a foto, basta clicar no botão “Ok” no 
final da página.

A sua foto fica imediatamente disponível no seu per-
fil. 

Pode mudar de foto quantas vezes quiser.

Como é que coloco um título no meu blog?
Pode criar e editar o título do seu blog acedendo à 
área de gestão, e clicando em “Preferências” na bar-
ra do lado esquerdo. Dos vários submenus escolha 
“Configuração”. Aparecem-lhe os campos onde pode 
inserir ou editar o título do seu blog (e a descrição). 

Criar um Blog no Sapo
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No final clique em “Guardar Alterações”. 

Está feito, e ainda só gastei 1 minuto.

Há muito mais coisas que pode fazer                                             
para personalizar o seu blog. Adicionar os links dos 
blogs dos seus amigos, colocar fotos e imagens no 
cabeçalho, mudar as cores, mudar os textos... existe 
um mundo à sua espera, mas agora vamos dedicar 
uns minutos do nosso tempo a publicar posts.

Agora que já tem o blog todo arranjado a seu gosto 
(pelo menos para já, que estas coisas mudam com 
facilidade e de vez em quando convém fazer uma 
mudança de imagem), já tem certamente ideia do 
que quer dizer no seu primeiro post, nem que seja 
um “Olá mundo, estou aqui”.

Basta aceder à área de gestão do seu blog, indican-
do o seu e-mail e respectiva password nos campos 
disponíveis para o efeito em http://blogs.sapo.pt e, 
depois de concluir este passo com sucesso, clicar 
em “Novo Post”.

Também nesta área há funcionalidades para todos 
os gostos e conhecimentos. Pode optar por escrever 
o título do post, e o respectivo texto, e publicá-lo de 
imediato (fica disponível em tempo real), mas tam-
bém pode usar algumas das muitas funcionalidades 
do editor. Passamos a destacar as que têm mais 
sucesso:

Inserir um link – Insira um link no seu post, para indi-
car uma fonte, ou para encaminhar os seus visitantes 
para uma página que tenha achado interessante (ou 
pouco interessante). Pode indicar que o link deverá 
abrir numa nova janela, entre muitas outras alterna-
tivas.

Inserir uma imagem – A plataforma de Blogs do SAPO 
não aloja imagens, mas isso não quer dizer que não 
possa ou não deva mostrar imagens no seu blog, 

Criar um Blog no Sapo
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pelo contrário. Tem duas formas de colocar imagens, 
ou indica o endereço em que essas imagens estão 
alojadas (um link externo) ou, se tiver uma conta no 
SAPO Fotos (grátis), pode directamente a partir da 
criação do post aceder a todos os seus álbuns, e 
escolher a foto que quer mostrar. 

Inserir um vídeo (ou ficheiro em flash) – À                     
semelhança do que ocorre com a inserção de im-
agens, também os vídeos não ficam alojados nos 
Blogs do SAPO, mas são mostrados. Basta iden-
tificar o endereço onde o vídeo está alojado (pode 
alojá-lo nas Homepages do SAPO, por exemplo, que 
é  mais um serviço grátis), e pode desde logo pré-
visualizar o vídeo.

E como se faz ?

Corrector ortográfico – Muitas vezes não é apenas o 
que escrevemos que nos representa, a forma como 
escrevemos também pode dizer muito acerca de nós 
próprios. Um post com erros de ortografia (a não ser 
que sejam erros propositados) é um post que perde 
de imediato muita credibilidade. O SAPO associou-
se à Priberam e disponibiliza o FliP, para corrigir 
(caso queira) a ortografia dos seus posts (e dos co-
mentários também).

Há muito mais para dizer acerca das funcionalidades 
da criação de posts, mas nada melhor do que a uti-
lização do serviço, explorar as funcionalidades, e 
aprender com a experiência. 

Afinal de contas, se a minha mãe tem um blog, toda 
a gente pode ter um blog

Ainda nos sobra um tempinho.

Aproveite  os minutos que lhe faltam para os 10 que 
demora este processo, e convide os seus amigos. 
Ter uma lista de amigos significa que pode escrever 
posts que se destinam exclusivamente a um deter-
minado grupo de amigos. Pode criar grupos de ami-
gos, e publicar posts só para uns, só para outros, ou 
para todos.

Além disso, ter amigos é sempre bom 

Pode começar a convidar os seus amigos.
Basta que aceda à área de gestão dos seus Blogs e 
clique em “Perfil”. Logo de seguida clique na opção 
“Amigos” do menu da esquerda.

Criar um Blog no Sapo
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Acede assim à área onde pode gerir os seus ami-
gos.
Para convidar amigos, basta que clique em “Convi-
dar Amigo”, preencha o campo do endereço de mail 
para onde quer que a mensagem seja enviada, e 
escreva a sua mensagem de convite. Será enviada 
a sua mensagem e as instruções necessárias para 
que o destinatário possa aceitar o seu convite.
Caso o destinatário opte por aceitar o seu convite 
(criando um blog no SAPO, caso ainda não o tenha), 
será automaticamente adicionado à sua lista de ami-
gos.
Se o destinatário optar por não aceitar o seu convite, 
não será adicionado à sua lista. 

Pronto. Estão gastos os 10 minutos que demora 
desde o registo até ao primeiro post, passando pela 
personalização.
Mais à frente já vamos explicar como é que damos 
a conhecer o nosso blog e a nossa homepage, mas 
para já, vamos às fotos.

Bem-vindo à Blogosfera

Criar um Blog no Sapo
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Criar uma Homepage

Mais uma vez, comecemos pelo princípio. Registar 
uma homepage. Ao registarmos uma homepage, es-
tamos a reservar espaço num  servidor que está dis-
ponível 24 horas por dia, e onde colocamos a nossa 
página, e esta fica acessível a partir de qualquer 
parte do mundo.

Vá à página inicial das Homepages do SAPO em 
http://homepages.sapo.pt

O processo é idêntico ao do mail, é clicar no botão 
que diz “Crie já”. 
Neste caso, siga a seta verde.

E é agora que vai usar o endereço de mail que 
registou. Nos campos de login e password insira,             
respectivamente, o seu endereço de mail e a sua 
password.

Vai entrar nas Homepages, e agora, muita atenção.

Tal como o seu endereço de mail, quando escolhe o 
endereço da sua página, também precisa de algum 
cuidado. Afinal de contas, esta vai ser a sua morada 
online. Não quer morar num sítio onde ninguém con-
siga ir ter, pois não? Então, e como na Internet tem a 

enorme vantagem de poder escolher a morada que 
quiser, faça o favor, escolha algo bonito, simples, e 
que tenha a ver consigo.

Portanto... o “domínio” ou a parte inicial do seu 
endereço está escolhido. Agora vamos ao sub-
domínio. Nada de complicado, das opções existentes 
escolha a que mais lhe agradar. Aqui não há regras, 
é mesmo só o que lhe parecer melhor. Não se es-
queça no entanto que o que escolher é o que vai ter 
na sua morada, e uma vez escolhido, não pode ser 
alterado.

No final deste processo, tem a sua página pessoal 
registada. O espaço já lá está, à espera que envie os 
seus ficheiros e os seus conteúdos.
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Upload de ficheiros

E pode fazê-lo de duas formas. Usando a Web ou 
usando o FTP. Ah! Mais um palavrão. FTP. O que 
é isto? É só um nome mais ou menos complicado 
para algo mais ou menos simples. FTP quer dizer 
File Transfer Protocol (Protocolo de transferência 
de ficheiros), e só o nome já explica tudo. Quere-
mos transferir ficheiros do nosso computador para a 
nossa homepage, portanto, usamos um protocolo de 
transferência de ficheiros.

Ah, pois, mas eu não sei como é que isso se faz, 
nem tenho um programa para fazer isso...

Tem sim senhor.

Toda a gente tem um browser ou, traduzindo para 
linguagem mais comum, toda gente tem o Internet 
Explorer, certo?

Não é preciso mais nada para transferir ficheiros, 
o Internet Explorer (ou o Firefox) servem perfeita-
mente.

No local habitualmente destinado ao endereço dos 
sites que visita (por exemplo www.sapo.pt) coloque 
o seguinte:

ftp://o_seu_endereço_nas_homepages_sapo@ftp.
homepages.sapo.pt

Veja o exemplo na imagem para o site http://jonas.
no.sapo.pt

No final clica na tecla “Enter” do seu teclado, e apa-
rece-lhe uma janela, onde são pedidos os dados que 
permitem ao sistema identificá-lo como o dono do 
espaço a que está a tentar aceder:

No username/Nome de utilizador, insere o endereço 
da sua página. Na password insere... a password.
No final clica em “Log On”.
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Upload de ficheiros

É isto que lhe aparece.

Mas o que é aquilo que já lá está? Um tal de index.
html?
É um ficheiro que o SAPO cria automaticamente, e 
que fica a dar as boas vindas aos visitantes do seu 
endereço, enquanto não são colocados os seus con-
teúdos. 

index.html é o nome que deve ter o seu ficheiro de 
entrada, isto é, aquilo que quer que as pessoas ve-
jam quando digitam o seu endereço. Não use maiús-
culas, nem altere o nome de qualquer forma, nestes 
casos index.html e Index.html são coisas totalmente 
diferentes.

No momento em que enviar o seu ficheiro index.
html, ele sobrepor-se-á ao que já lá está e passa a 
ser mostrado quando alguém visitar a sua página.

Ok, já estamos ligados à nossa área nas Homepage, 
e agora? Como é que envio para lá os ficheiros?

Duas hipóteses. Ou usa a barra de navegação       
lateral “My documents” e navega no seu computa-
dor até chegar aos ficheiros que pretende transferir, 
ou pega nos ficheiros, e “arrasta-os” para dentro da 

janela do Internet Explorer onde abriu a sessão de 
FTP com a sua homepage no SAPO. Depois é só 
esperar que se conclua a transferência dos ficheiros 
e já está.

Esta transferência vai demorar mais ou menos tem-
po, consoante a velocidade do acesso à Internet que 
está a usar e dependendo também do tamanho e da 
quantidade de ficheiros que vai enviar.

No final do processo, basta fechar a janela do Inter-
net Explorer, ou aproveitando que está mesmo ali, 
visitar de imediato a página que registou e cujos fi-
cheiros acabou de enviar.

Pode, a qualquer momento, repetir o processo, en-
viando novos ficheiros, ou alterando ficheiros que já 
tenha enviado antes, acrescentando ou retirando o 
que quiser. É ao seu ritmo, ao seu gosto, à sua ve-
locidade.
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Colocar um vídeo/áudio num blog ou  
Homepage

Esta é uma parte um pouco mais técnica mas mes-
mo assim relativamente fácil de fazer. 
Vamos mesmo ter de usar HTML neste processo. 

Em primeiro lugar vamos ter de fazer upload do fi-
cheiro vídeo ou de áudio para uma página pessoal.        
Se ainda não criou uma página pessoal no SAPO 
porque a ideia era apenas fazer um blog, vai ter de
o fazer agora. Isto porque o ficheiro terá de ficar
alojado em algum lado. 

Veja como criar a homepage em registar homepage 
(Publicar) . Depois de criada, é só clicar em Envio de 
ficheiros no menu de edição

De seguida em Envio/Upload via Web , fazer browse 
e procurar no disco do computador a localização do 
ficheiro a  utilizar e clicar em ENVIAR.

Se tudo correu bem, o ficheiro vai aparecer na área 
Directório Actual junto do índex.html.

Se a ideia é usar um ficheiro áudio (mp3, wav) o 
processo até aqui é exactamente igual.

A diferença vem agora. 

Se for um vídeo no blog ou numa homepage, em 
novo post será necessário passar á edição HTML, e 
colocar um pequeno código HTML:

<center> <embed type=”video/wmv” src=”http://no-
medaminhapagina.no.sapo.pt/omeuvideo.wmv” 
loop=”false” controls=”TRUE” autoplay=”no”></em-
bed></center>

Apenas será necessário substituir: nomeda                
minhapagina pelo nome que foi dado à página cri-
ada e omeuvideo pelo nome do ficheiro que se fez 
upload.

Publicar Vídeo / Áudio

BLOGS
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Para saber mais sobre HTML visitar este site: http://

www.artifice.web.pt/tutoriais/cntd/tut_html1.html

Publicar Vídeo / Áudio

Para um ficheiro áudio o processo é praticamente 
idêntico, usar o seguinte código:

<center><embed width=”120” height=”25”
type=”audio/mpeg” src=”http://aminhapagina.
no.sapo.pt/omeuaudio.mp3” controls=”TRUE” 
autoplay=”false”></embed></center>

Substituir nomedaminhapagina pelo nome que foi 
dado à página criada e  omeuaudio pelo nome do 
ficheiro áudio ao qual já se fez upload. 

O aspecto será este: 

Vamos editar o ficheiro a partir do qual pretendemos
disponibilizar o ficheiro de vídeo. Neste caso
específico, o index.html. Seleccionamos o ficheiro na
área de edição, e clicamos no botão "Editar".



HOMEPAGES

Entramos no editor de html:
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Publicar Vídeo / Áudio

Localizamos a área onde pretendemos disponibilizar
o vídeo e colocamos aí o cursor:

Colocamos o código html que fará servir o ficheiro
de vídeo, na localização escolhida:
  
 
 
 
 
 
 
 






O video já está disponível na homepage.
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Para um ficheiro áudio o processo é praticamente 
idêntico, usar o seguinte código:

<center><embed width=”120” height=”25”
type=”audio/mpeg” src=”http://aminhapagina.
no.sapo.pt/omeuaudio.mp3” controls=”TRUE” 
autoplay=”false”></embed></center>

Substituir nomedaminhapagina pelo nome que foi 
dado à página criada e  omeuaudio pelo nome do 
ficheiro áudio ao qual já se fez upload. 

<center> <embed type=”video/wmv” src=”http://no-
medaminhapagina.no.sapo.pt/omeuvideo.wmv” 
loop=”false” controls=”TRUE” autoplay=”no”></em-
bed></center>

Apenas será necessário substituir: nomeda                
minhapagina pelo nome que foi dado à página cri-
ada e omeuvideo pelo nome do ficheiro que se fez 
upload.
 
No final, clicamos em Gravar. 
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No final, publique, clicando no botão “Publicar” 
e o seu site fica imediatamente disponível, e em             
funcionamento.

Pode repetir o processo (ou parte do processo) as 
vezes que quiser, pode mudar completamente o    
design e a estrutura sem perder quaisquer conteú-
dos (textos ou imagens que já estejam online), mu-
dando-lhes apenas o aspecto.

Poderá acrescentar páginas novas, actualizar pági-
nas antigas, colocar ligações para o seu blog, para 
as suas fotos.

De que é que está à espera?

Agora já não tem desculpas para não ter uma  
homepage.

Templates
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Antigamente, existiam umas máquinas fotográficas 
que davam uma trabalheira, para além de que se 
gastava imenso dinheiro com as revelações. Nunca 
sabíamos muito bem quais eram as fotos que tinham 
ficado bem e quais as que não tinham ficado nada de 
jeito senão depois de revelarmos o rolo. Sim, havia 
umas coisas chamadas rolos, onde estava a pelícu-
la, que depois precisava de ser revelada.

E mesmo depois de termos essas fotos, em papel, 
precisávamos de equipamento específico para as 
colocarmos no nosso computador (um scanner).

Enfim, uma seca.

Nos dias que correm, os rolos foram substituídos por 
cartões de memória, e a ligação ao computador é di-
recta. Como não gastamos um dinheirão com revela-
ções, e podemos escolher a foto assim que a tiramos 
(esta fica, esta vou apagar porque não ficou nada de 
jeito), temos mais fotografias. É mais fácil, é mais 
barato, é mais rápido.

Só há um pequeno problema. Aliás, dois pequenos 
problemas. À semelhança dos álbuns de fotografias 
em papel, estas fotos digitais, também ocupam es-
paço, e também precisam de ser organizadas.

Por isso é que o SAPO criou o SAPO Fotos.

O SAPO Fotos é “apenas” um serviço que lhe per-
mite alojar as suas fotos (mantendo-as privadas 
ou públicas), permite-lhe ainda organizá- -las por 
álbuns, e encontrá-las mais facilmente (usando as 
Tags que já vamos explicar mais daqui a bocadinho). 
Tem também a enorme vantagem de poder mostrar 
as fotos que quiser, a quem quiser, mesmo a quem 

Registar uma área no Fotos SAPO
está longe, e muito mais rapidamente.

É só vantagens.
Além disso, nada de complicações. É tudo fácil.

Vá até à página inicial do SAPO Fotos, em 
http://fotos.sapo.pt

Mais uma vez uma seta a indicar-lhe o caminho. 
Faça o que a seta indica, “Registe-se”.

Só precisa do endereço de mail e respectiva           
password, que já tem.

Preencha com cuidado a parte do nickname, porque 
não o poderá alterar mais tarde. Tirando isso, é sem-
pre a andar.
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Uma vez chegado à área de gestão, pode de ime-
diato começar a enviar as suas fotos. O limite são os 
250 Mb de espaço disponíveis. E olhe que 250 Mb é 
muito mega. 

O sistema indica-lhe qual a percentagem de espaço 
que vai ocupando, de forma a que melhor possa gerir 
estes seus álbuns virtuais.

Para enviar fotos, pode usar vários métodos. Usando 
a Web, e basta ir à sua área e clicar em “Upload” (que 
é uma alternativa mais curta de “transferir as suas 
fotos para o Fotos SAPO”).

Clique em “Browse” (que é uma alternativa a            
“procurar a foto no seu computador”) . Pode enviar 
8 fotos em simultâneo e pode desde logo decidir se 
quer as suas fotos públicas ou privadas. Indique ain-
da se quer as suas fotos num álbum em especial, ou 
se vão para o álbum “Ao molho” que, tal como nome 
indica, é para onde vão todas as fotos, se o seu dono 
não as quiser colocar de imediato num álbum que já 
tenha criado. Ficam na “molhada” até que seja o mo-
mento de se organizarem as fotos por álbuns.

Pode também enviar a suas fotos por mail.

Isso mesmo, o velhinho mail é útil também nesta 
situação.

Mas, para que endereço de mail vou eu enviar as 
fotos?
Cada SAPO Fotos tem um endereço de mail asso-
ciado, que é único, para onde são enviadas as fo-
tos.

Para saber qual é o endereço de mail para onde 
deve enviar as suas fotos vá
a upload (segundo botão a contar da esquerda na 
barra de navegação)  escolha
a opção enviar por e-mail no lado direito do ecrã, e 
nessa página vai
visualizar o seu mail pessoal que lhe permitirá  poder 
fazer upload de fotos
por e-mail.

Registar uma área no Fotos SAPO
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Depois é enviar o mail, para o endereço que lhe foi 
atribuído, e anexar as imagens, como se fosse en-
viá-las para alguém.
Está feito.

Mas há mais.
Vamos supor que tem as fotos TODAS do seu casa-
mento, do seu filho, da festa da semana passada, da 
visita de estudo, qualquer coisa. São muitas fotos. 
Estar a enviá-las em parcelas de 8, pode tornar-se... 
vá, uma seca.

Daí o SAPO ter criado um programinha (basicamente 
uma ferramenta de trabalho) que se instala no seu 
computador, e que lhe permite, entre muitas outras 
coisas, enviar fotos por “atacado”. 
Basta fazer o download (transferir para o seu com-
putador) este programinha, e usá-lo logo, porque foi 
feito de uma forma simples e intuitiva.

Para fazer o download desta ferramenta, basta que 
na sua área clique na frase “download da aplica-
ção”.

Para utilizar esta aplicação basta clicar ícone (SAPO 
Fotos) que ficou no seu desktop (mais uma forma de 
dizer “área de trabalho”). 

Surgirá o seguinte ecrã onde deve introduzir o seu 
e-mail (o do costume), respectiva password e clicar 
em “Ligar”. 

Registar uma área no Fotos SAPO
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Após efectuar a autenticação com sucesso, isto é, 
após o sistema ter verificado que os dados que in-
seriu estão correctos,  surgirá o seguinte ecrã:

A aplicação é intuitiva pois permite enviar fotos 
através duma simples acção de drag and drop (pron-
to, é mais uma forma de dizer que pode seleccionar 
as fotos que pretende enviar, arrastá-las para cima 
deste ecrã, e soltá-las lá, que o programita faz o res-
to).

É fácil enviar fotos! Basta abrir a pasta onde estão 
as fotos, seleccioná-las e arrastá-las para dentro da 
aplicação. São automaticamente geradas cópias das 
suas fotos dentro da aplicação, mantendo-se os fi-
cheiros originais no seu computador. 

Ao arrastar as suas fotos para dentro da aplicação, 
elas não são imediatamente enviadas para a sua 
área de fotos, é preciso ter calma e dar-lhe a si al-
gum tempo para efectuar várias alterações antes de 
as enviar, isto se quiser, claro.

As fotos encontram-se predefinidas no tamanho opti-
mizada para Web. Pode modificá-las para o tamanho 
original das fotos.

Para efectuar a modificações nas fotos é necessário 
seleccioná-las primeiro. 
Para seleccionar apenas uma fotografia basta clicar 
em cima da fotografia e depois escolher o botão de 
acção pretendido. 
Para seleccionar várias fotografias, com a tecla 
“CTRL” premida, clicar nas fotografias pretendidas e 
depois efectuar a acção pretendida. 
Para seleccionar todas as fotos, basta clicar na 
primeira foto e, com a tecla “Shift” pressionada, clicar 
na última (e todas ficarão seleccionadas). 
Estando tudo a seu gosto, basta clicar no botão que 
diz “Enviar”, e pronto. O programa trata do resto. 

Registar uma área no Fotos SAPO
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Claro que há muito mais coisas que pode fazer na 
sua área de fotos. Mas isto é o básico, também não 
queremos ser exaustivos (que isto pode tornar-se 
cansativo e não é essa a ideia).

Pronto, já tem homepage, já tem blog, já tem uma 
área no Fotos SAPO, o que é que falta?

Agora a sua presença online já está mais ampla, 
maiorzita. O que é que falta? Ah! Comunicar. Como 
dissemos há pouco, tão importante como estar on-
line, é dar a saber que estamos online, e isso faz-se, 
comunicando (e não só, mas já lá vamos).

Registar uma área no Fotos SAPO
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Olá mundo, aqui estou eu. Use a pesquisa 
e directório a seu favor.

Tal como já referimos algumas vezes antes, para 
além de estar online, é igualmente importante fazer 
saber que está online.

Se pode usar o mail e o Messenger para dar a         
conhecer a sua presença aos seus amigos, conhe-
cidos, familiares e restantes contactos, como fazer 
para dar a conhecer os seus conteúdos, a sua pá-
gina, o seu blog ou as suas fotos a pessoas cujo 
contacto não tem?

Há muitas formas.

Se voltarmos quase ao princípio deste e-book, veri-
ficará que para encontrar determinados conteúdos 
(textos, imagens, vídeos, etc.) recomendamos que 
use a pesquisa. Agora estamos do outro lado, já não 
queremos encontrar nada, queremos que nos en-
contrem a nós. A resposta continua a ser: pesquisa.

A maior parte dos bons motores de pesquisa, como é 
o caso do SAPO,  usam “crawlers” (são ferramentas 
que andam pela Web, e indexam na pesquisa todas 
as novidades que vão encontrando). Com estes nem 
precisa de se preocupar, porque mais tarde ou mais 
cedo hão-de passar pela sua homepage ou pelo seu 
blog, e estes ficarão de imediato disponíveis para 
serem pesquisados.

Depois de indexados (incluídos como conteúdos po-
tencialmente pesquisáveis) os seus conteúdos são 
devolvidos nos resultados de determinadas pesqui-
sas, consoante o interesse que aparentem ter. Este 

interesse é calculado pelos motores de pesquisa que 
avaliam a actualidade da informação, o número de 
links que existem para a sua área, o número de visi-
tas, e mais umas coisas que são segredo, e também 
aqui o segredo é a alma do negocio.

Portanto esta introdução foi só para explicar que no 
que diz respeito à maior parte das boas pesquisas, 
não precisa sequer de se preocupar, porque existem 
os tais “crawlers” a trabalhar para si.

No entanto, o SAPO dispõe de outras ferramentas 
que lhe permitem criar notoriedade e dar visibilidade 
ao seu trabalho. 
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O Directório é, por razões históricas e não só, um dos 
mais importantes serviços do SAPO. É um dos mais 
importantes porque, na realidade, foi o primeiro. 
Um conjunto de endereços de sites, com links, orga-
nizados por temas, de forma a que fosse mais fácil a 
quem procurava determinada informação, encontrá-
la, seguindo a árvore temática sugerida pelo SAPO. 
Foi também assim que começaram os mais impor-
tantes sites internacionais.

Como é óbvio, o Directório do SAPO mantém-se até 
hoje, embora se presuma que os primeiros sites ali 
apontados já não andem por lá. Nestas coisas da In-
ternet tudo tem a mania de ser efémero. Na história 
do Directório, já foram adicionados e removidos mui-
tos sites. São adicionados sempre que a equipa do 
Directório os descobre, são removidos sempre que 
deixam de existir.

Todo este trabalho é feito manualmente, o que per-
mite categorizar os sites. Não há nenhum servidor, 
nenhuma máquina que consiga visitar um site e    
catalogá-lo correctamente.

Tudo isto para explicar que adicionar o seu site ao 
Directório é outra forma importante de se dar a
conhecer. Não só porque qualquer visitante lá pode 
chegar seguindo as categorias temáticas que o Di-
rectório propõe, mas também porque quando é  
efectuada uma pesquisa, são também apresentados 
resultados encontrados no Directório.

É simples e grátis adicionar o seu site ao Directório. 

Basta que vá até à página inicial do Directório em 
http://directorio.sapo.pt

Directório

Novamente siga a seta laranja e clique em “Registe 
o seu site”. Tem dois serviços à sua disposição. O 
Normal e o Expresso. O normal destina-se a quem 
não tenha pressa, e é grátis. O Expresso, é para 
quem precisa de ter o seu site presente no Directório 
praticamente de um dia para o outro, ou para quem 
queira adicionar um site comercial, e trata-se de um 
serviço pago.

Depois de escolher a opção que mais se adequa à 
sua situação, preencha os campos que lhe são apre-
sentados.

Pronto, agora o trabalho é do SAPO. Um elemento 
da equipa do Directório irá receber a sua candida-
tura e vai visitar o seu site (tunga, mais uma visita), 
e vai verificar pessoalmente se o seu site preenche 
os requisitos mínimos de qualidade, para estar apon-
tado no Directório. 

No Directório não são aceites sites vazios (sem 
qualquer conteúdo) nem aqueles cujo teor desres-
peite as regras do Serviço. São regras de senso co-
mum, nada de extraordinário, mas recomendamos 
uma leitura.
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TAGS ou Etiquetas

Outra forma de dar a conhecer os seus conteúdos, é 
a categorização. Vamos falar de tags.

Ora aqui está mais uma daquelas palavras que pa-
recem um termo técnico complicado, mas não, tags 
são apenas etiquetas.

Imagine uma série de livros, todos iguais por fora, 
arrumadinhos numa prateleira (é uma analogia para 
os conteúdos todos que estão online). Como é que 
sabe sobre o que trata cada livro? São todos iguais 
e não têm nada escrito por fora.

Não sabe.

A não ser... que alguém lhes escreva qualquer coi-
sa, que permita identificá-los, catalogá-los. Numa 
enciclopédia, as letras do alfabeto distinguem os           
volumes uns dos outros.

Como poderá adivinhar, esta técnica de associar 
palavras ou letras às coisas para que mais rapida 
-mente as consigamos identificar não é nova. Tem 
uns milhares de anos.

Pois, são tags.

Tags (ou etiquetas) são palavras que podem (e 
devem) ficar associadas aos seus conteúdos. Por 
exemplo, num blog, se publica um post a falar do 
Campeonato Mundial FIFA 2006 e da prestação da 
selecção portuguesa, vai atribuir as tais tags, ao 
post. 

Neste caso em específico seriam várias as tags: 
“campeonato”, “mundial”, “fifa”, “2006”, “selecção”, 
“portuguesa”, “futebol”.

Sempre que adicionar uma tag a um post do seu 
blog, a sua tag irá constar da lista de tags da co-
munidade, sendo apresentada, juntamente com os 
restantes posts que tenham a mesma tag, quando 
alguém clica na tag.

Portanto, se uma pessoa for ao Serviço de Blogs, à 
procura de textos e opiniões sobre o Mundial FIFA 
2006, vai ver essas tags, e vai clicar nessas tags, 
para encontrar o que procura.

Bingo. Dá de caras com o seu post e,                       
consequentemente com o seu blog.
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Não ao SPAM

A diferença entre divulgar e melgar

É aqui que voltamos a falar de spam.

É interessante divulgar o seu blog, a sua página, as 
suas fotos. Principalmente se o divulga junto de pes-
soas a quem os seus conteúdos interessam. Tipica-
mente as pessoas que o rodeiam e de quem gosta, 
a quem quer dar a conhecer mais de si, dos seus 
interesses e do seu trabalho.

Pode usar o mail e o Messenger como forma de co-
municar a essas pessoas que tem um novo blog, ou 
que registou uma área de fotos e lá colocou as fotos 
daquele passeio, ou daquela festa.

No entanto, um mail basta. Não sobrecarregue 
as caixas de correio das pessoas (conhecidas e 
desconhecidas) com mensagens, não deixe comen-
tários sem sentido nos blogs de estranhos (o meu 
site é muito giro, visite). Essa é a melhor forma de 
afugentar pessoas que de outra forma até estariam 
interessadas em visitar o seu blog, e conhecê-lo um 
pouco melhor.

É bom ter visitas no nosso espaço, mas apenas 
quando essas visitas são fruto do interesse dos seus 
conteúdos ou da sua pessoa. 

A melhor forma de assegurar visitas ao seu espaço 
online, é investir na qualidade dos seus conteúdos. 
Hoje em dia, a quantidade é imensa, mas a quali-
dade é difícil de encontrar. Assegure a qualidade dos 
conteúdos, e eles atrairão as visitas como se fossem 
um íman.

Acima de tudo, não melgue as pessoas. 
Se construir uma boa página, elas virão.
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E - mail

Perceber que o e-mail é muito mais do que 
um endereço de correio electrónico.

Bom, nesta altura do campeonato já é mais do que 
óbvio porque é que o mail é muito mais do que um 
mero endereço de correio electrónico.

Não só é o nosso cartão de visita, como também é 
com o mail e respectiva password que temos acesso 
a uma série de serviços que, tendo o mail como pólo 
centralizador, estão integrados e comunicam uns 
com os outros. Usando o meu blog, posso imediata 
e automaticamente aceder à minha área das Fotos, 
e escolher qual é a foto que quero publicar no meu 
post. Usando o meu mail, consigo aceder ao SAPO 
Messenger e comunicar em tempo real com todos os
meus amigos.

O nosso mail é a nossa primeira presença online, 
é uma ferramenta que nos permite enviar e receber 
e, nestas coisas da comunicação, ouvir é tão impor-
tante como falar. Receber é tão importante como 
enviar.

Então, já temos um endereço de mail (que por sinal 
usámos para registarmos todos os outros serviços 
do SAPO), como é que usamos o mail?

Vamos até à página inicial do mail SAPO em http://
mail.sapo.pt

Lá está a seta laranja a indicar que é ali que de-
vemos inserir os nossos dados. O endereço de mail 
completo e a respectiva password.

No final, clicar em “Entrar”. O que é que acontece? 
Entramos na nossa caixa de correio, pois claro.

Depois, dependendo do que quiser fazer, é clicar 
nos botões respectivos. Escrever uma mensagem. 
Adicionar contactos à sua lista de contactos. Inserir 
um evento no seu calendário. Criar pastas que lhe 
permitam organizar melhor a sua correspondência. 
Tudo isto, e muito mais.
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E - mail

O mail é uma importante e rápida forma de comuni-
cação. Por ser tão fácil e tão rápido, pode também 
tornar-se numa ameaça. Já ouviu falar de spam? 
Não? Tem sorte. Mas se calhar não ouviu falar de 
spam, mas já sentiu os efeitos do spam.

Já alguma vez chegou à sua caixa de correio e 
encontrou mensagens que não solicitou, ou cuja 
temática não lhe interessasse? Pronto. Isso é spam. 
Por spam entende-se toda a correspondência não 
solicitada. À semelhança do que ocorre nas nossas 
caixas de correio, as de correio tradicional, que cada 
vez mais estão cheias de lixo, e de folhetos e de pan-
fletos e de coisas que vão direitinhas para o caixote, 
na Internet é a mesma coisa.  Só que mais barato 
para quem envia esse tipo de correspondência, já 
que não tem de gastar dinheiro em folhetos, revistas, 
panfletos, nem em pagar a pessoas que se dêem ao 
trabalho de andar de caixa de correio em caixa de 
correio, a distribuir essa “correspondência”.

Por vezes, nós próprios tornamo-nos “spammers” se 
não prestarmos atenção.

Evite as “chain-letters” que são aquelas missivas em 
que nós temos de fazer qualquer coisa (como acor-
dar de manhã e dizer em primeiro lugar – O mundo é 
um local feliz e cheio de amor), e depois encaminhar 
essa mensagem para 150 contactos da nossa lista, 
porque se não o fizermos nos cai uma perna, ou não 
vamos conseguir arranjar emprego, ou porque nun-
ca mais seremos felizes. Todos os mails com este 
tipo de mensagem são para ir directamente para o 
lixo. Não corra a enviar estes mails para toda a sua 
lista de contactos, porque a sua felicidade, as suas 
pernas e o seu emprego não dependem do envio de 
um simples mail. Tão simples como isso. Lixo, di-

rectamente.

E as piadas? Ah! Essas são giras. Recebemos uma 
mensagem de um amigo, que tem 3 vídeos fantásti-
cos, e achamos um piadão, e queremos partilhar 
com os nossos amigos todos. Pegamos na men-
sagem (que por sinal é ENORME e pesadíssima) e 
toca de enviar para toda a gente da nossa lista de 
contactos.

Errado. 
Se quer partilhar os vídeos, é simples, coloque-os no 
seu blog, e envie um mail aos seus amigos (ou certi-
fique-se de que eles subscrevem o RSS do seu blog) 
e pronto. Poupa uma série de inconvenientes, quer a
si (pelo tempo que teria de estar à espera que o mail
saísse da sua caixa de correio), quer à rede (que 
assim não fica sobrecarregada), quer aos seus 
amigos, que demorariam algum tempo até  
conseguirem ver o mail como deve ser.

É por isso necessário algum cuidado, não só na 
forma como divulgamos o nosso endereço de mail, 
como com os endereços de mails dos nossos ami-
gos e conhecidos. Um endereço de mail é como um 
número de telefone. Não dá o seu número de tele-
fone a estranhos, pois não? Com o mail é a mesma 
coisa. Já aprofundaremos este tema, no Capítulo 
Segurança.
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Boas maneiras online.

Nada de extraordinário, mas aqui também há umas 
regras de bom tom, e que identificam quem as usa 
como pessoa habituada a estas coisas das novas 
tecnologias.

As regras de boas maneiras (que também se chamam 
netiquette), servem não só para promover uma co-
municação cordial mas também para assegurar uma 
comunicação segura.

Aqui ficam algumas regras que deve tentar seguir:

1 – Nunca escreva apenas em maiúsculas. Nes-
tas coisas do online, escrever exclusivamente em 
maiúsculas, é sinal de que está a gritar. Não grita 
com as pessoas cá fora, pois não? Então não grite 
com as pessoas, quando está online.

2 – n escr3va assim, se n souber q a pess q esta do 
outro ldo p3rc3b3 aqulo q qr dzr.

As abreviaturas e a escrita típica de um SMS podem 
ser obstáculos à comunicação. Para além disso, ha-
bituamo-nos a escrever assim, e sem dar por isso, 
começamos a escrever com abreviaturas mesmo nos 
sítios onde não é suposto (um exame, um relatório, 
um trabalho, etc.).

3 – Claro que depois há as mesmas regras que      
existem cá fora, não chame nomes, não bata, não 
cuspa no chão se faz favor. 

Haverá mais para dizer sobre estas regras das boas 
maneiras, mas vamos tratá-las no capítulo da segu-

Netiquette

rança, já que é esse o seu principal objectivo. Segu-
rança primeiro, boas maneiras depois.

87/90



SEGURANÇA

Sim, nós sabemos. Toda a gente fala disto, e já tudo 
é sabido, mas nunca é demais falar do que é im-
portante, porque estas coisas não acontecem só aos 
outros.

A segurança online não é diferente da segurança 
cá fora. É apenas necessário que saiba reconhecer 
os sinais, use precaução e bom senso e aplique as 
mesmas regras que usa no seu dia-a-dia.

Se passar por um estranho na rua, não lhe dá o 
seu número de telemóvel, pois não? Aliás, o mais 
provável é que se afaste sem sequer responder, se 
esse estranho lhe dirigir a palavra.

Obviamente online, as coisas são um pouco diferen-
tes, mas as regras são mais ou menos as mesmas. 
Para si e para os outros.

Assegurar a sua segurança e a segurança 
de terceiros. 

Há dois tipos de segurança que convém assegurar. 
A mais fácil é a segurança do equipamento com que 
trabalha. As questões técnicas pois então.

Nos dias que correm, a Internet tem muita coisa, tem 
também muita bicharada, os vírus e afins. E se há al-
guns que são meramente incómodos, outros há que 
danificam seriamente os sistemas mais frágeis. Por-
tanto, assegure-se de que o seu equipamento está 
bem protegido (com uma firewall) e que actualiza os 
seus anti-vírus com frequência.

Esta é a parte fácil. Instala-se a coisa e com apenas 
alguma manutenção simples e rotineira, aquilo fun-
ciona sozinho, fazendo o seu trabalho.

Mas nós podemos ajudar as nossas ferramentas de 
protecção, não lhes dando trabalho extra. Assim, 
não aceite ficheiros de desconhecidos. Não aceita 
doces de estranhos, pois não? Pronto, é o mesmo, 
ficheiros também não. Nem doces nem ficheiros.

Não abra documentos que lhe pareçam suspeitos. 
Não ingere um alimento que lhe cheire mal, pois 
não? Pronto, nem alimentos malcheirosos nem              
documentos. Faça o mesmo a ambos, ou não aceite, 
ou ponha-os no lixo.

Caso encerrado.

Estas são as questões técnicas, de segurança.

Mas sabia que a maior parte dos problemas de se-
gurança se devem à engenharia social? É através 
do contacto entre as pessoas, mais do que por fra-
gilidades dos sistemas, que ocorrem os problemas 
de segurança. Assim, mais algumas regras ajudam 
a distinguir os procedimentos seguros dos procedi-
mentos mais arriscados, e até mesmo perigosos.
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A sua password. É isso mesmo, sua. Sua e de 
mais ninguém. Mas mais ninguém MESMO! Nem o        
melhor amigo, o vizinho, o marido, a namorada, o 
cão, o gato ou o periquito. Não dá o pin do seu cartão 
multibanco a ninguém, pois não? É o mesmo, o PIN 
é uma password constituída por números. Não se 
dá. E altera-se com frequência, já agora.

E quem diz a password, diz tudo o resto. Os seus 
dados pessoais, nome, idade, morada, telefone, es-
cola, trabalho, números de telefone. São os seus da-
dos pessoais, apenas os deve disponibilizar a pes-
soas que conheça bem. Quando dizemos “pessoas 
que conheça bem” não nos referimos ao nick com 
quem falou meia dúzia de vezes no Messenger, ou 
num chat. Não se conhece quem está por trás de um 
nick, em meia dúzia de conversas.

Por mais cínico que possa parecer, desconfie de 
desconhecidos, e online, começamos todos por ser 
desconhecidos. Nada lhe garante que a “belita” de 
15 anos, não é na realidade o António de 54. Nunca 
sabemos quem está do outro lado. Mesmo as web-

cams, que às vezes são úteis, podem ser usadas de 
forma indevida e falsa.

Caso se sinta desconfortável com o teor de um con-
tacto (mail, messenger, comentário num blog, etc., 
etc., etc.) fale com os que lhe estão mais próximos, 
e explique-lhes o que se está a passar. Não respon-
da. Se as mensagens forem persistentes, contacte 
a polícia, que, para além de ter competências nesta 
área (e infelizmente, experiência), é para isso que 
existe, para nos proteger quando nos sentimos ame-
açados.

Desconfie das insistências. Quanto mais alguém in-
sistir em obter um dado pessoal (mail, telefone, mo-
rada, escola), mais veemente deve ser a “nega”.

Dependendo da sua idade, aconselhe-se com os 
seus pais, professores, colegas, amigos, famili-
ares. Alguém com mais experiência pode ajudar a           
despistar uma desconfiança injustificada, ou pode 
ajudar a confirmar um comportamento estranho. Nin-
guém nasce ensinado e perguntar não ofende.

Dar o “salto” para a vida real. NUNCA marque um 
encontro com um desconhecido, sem informar os 
que o rodeiam. E se quer mesmo conhecer aquela 
pessoa, marque o encontro para uma hora de movi-
mento, num local público. O conto de fadas, na reali-
dade pode tornar-se um pesadelo. Está na sua mão 
garantir a sua segurança.

Não tenha pressa. Se alguém estiver mesmo              
interessado em conhecê- lo, pode estar impaciente, 
mas se for alguém que valha realmente a pena, com-
preenderá as suas hesitações, e esperará. Avance 
para um encontro apenas e quando se sentir con-
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fortável com a ideia, e se não se sentir confortável 
nunca, então nunca marque o encontro.

O que se aplica a nós, aplica-se também aos outros, 
isto é, os dados pessoais dos seus amigos, não são 
seus, são dos seus amigos, nunca os divulgue a nin-
guém que não pertença ao grupo. Se quer enviar um 
mail para várias pessoas, e não tem a certeza de que 
todas as pessoas se conhecem e têm os endereços 
de mail umas das outras, envie o mail para si próprio, 
e coloque os endereços de mail dos restantes desti-
natários no campo Bcc (blind carbon copy). Isto sig-
nifica que todos recebem o mail, apenas não terão 
acesso a todos os endereços para onde a mensa-
gem foi enviada.

Por último, as compras. Muito se fala de fraudes com 
cartões de crédito, na Internet. Mas as fraudes com 
cartões de crédito que mais prejuízo dão são as que 
não têm nada a ver com Internet.

Mas, também aqui, devemos usar algumas pre-
cauções, basicamente as mesmas que usamos no 
nosso dia-a-dia. Não passa o seu cartão de crédito 
para a mão de qualquer pessoa, pois não? Tam-

bém online deverá certificar-se de que a entidade a 
quem está a fornecer o  número de cartão de crédito 
é conhecida e reconhecida. Como é que distingue 
as “boas” das “más”? Aplica as mesmas regras que 
cá fora, e junta-lhe as regras de credibilidade que 
mencionámos mais acima (quando lhe falámos na 
credibilidade dos seus conteúdos).

Este último capítulo parece um pouco dramático, e 
até é, mas há pessoas mal intencionadas em todo o 
lado, e a Internet não é excepção, claro.

Mas a Internet é um mundo que está à sua espera, 
aguarda o seu contributo, seja simples seja sofisti-
cado, seja elementar seja elaborado.

Se há coisa que a Internet nos ensina é que a diver-
sidade de gostos é quase inesgotável.

Quase inesgotável é também o que pode retirar da 
Internet. 

Este e-book pretendeu iniciá-lo, abrir-lhe os horizon-
tes, afugentar eventuais receios, mostrar-lhe que 
não é preciso saber falar de bits e bytes para estar 
online.

Demos-lhe a cana. A pesca agora é toda sua. 

Divirta-se.
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